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Περίληψη 

Οι πλημμύρες αποτελούν ένα από τα σημαντικότερα φυσικά φαινόμενα με έντονες και εκτενείς 

περιβαλλοντικές, κοινωνικές και οικονομικές συνέπειες τόσο στο Ελληνικό χώρο, όσο και σε 

παγκόσμιο επίπεδο. Στα πλαίσια της παρούσας εργασίας μελετήθηκε η πλημμυρική 

δραστηριότητα του Ποταμού Αράχθου για τμήμα μήκους 11.0 km κατάντη του υδροηλεκτρικού 

φράγματος Πουρνάρι Ι. Η πλημμυρική δραστηριότητα του υπό μελέτη τμήματος κρίνεται 

ιδιαίτερα σημαντική δεδομένου ότι αυτό περικλείει την πόλη της Άρτας και βρίσκεται σε μικρή 

απόσταση από αυτή. 

Η υδραυλική προσομοίωση του φαινομένου έγινε με χρήση των λογισμικών HEC-RAS 4.0 και 

LISFLOOD-FP 4.5.0, κάνοντας παραδοχή για μόνιμη ροή. Το πρώτο μοντέλο υποστηρίζει 

μονοδιάστατη ροή, ενώ το δεύτερο υιοθετεί μεθόδους για την προσομοίωση του αναπτύγματος 

της πλημμύρας εγκάρσια στο κυρίως ρεύμα ροής (ψευδο-διδιάστατη ανάλυση). Ως αρχικό 

δεδομένο χρησιμοποιήθηκε το Ψηφιακό Μοντέλο Εδάφους, ύστερα από επεξεργασία στο 

πρόγραμμα ArcGIS 10.0. Το ίδιο πρόγραμμα χρησιμοποιήθηκε και για τη σύνθεση των 

αντίστοιχων πιεζομετρικών και πλημμυρικών χαρτών για κάθε σενάριο προσομοίωσης.   

Για την υδραυλική προσομοίωση επιλέχθηκαν τέσσερα διαφορετικά σενάρια διαχείρισης του 

εκχειλιστή του φράγματος Πουρνάρι Ι, τα οποία προκαλούν πλημμυρικές αιχμές διαφορετικού 

μεγέθους (διαφορετικής περιόδου επαναφοράς). Πιο συγκεκριμένα, εκτός από την παροχή 

αιχμής που αντιστοιχεί στην πραγματική λειτουργία του εκχειλιστή, κατά το επεισόδιο της 

περιόδου 28-31/12/2005, μελετήθηκαν ακόμα τρία εναλλακτικά σενάρια τα οποία 

διαφοροποιούνται ως προς το χρόνο ανοίγματος του εκχειλιστή σε σχέση με την μέγιστη εισροή 

στον ταμιευτήρα. Επίσης, πραγματοποιήθηκε υδραυλική προσομοίωση για μια εκτίμηση της 

παροχής αιχμής της πλημμύρας η οποία συνέβη την 1/2/2015. 

Τα αποτελέσματα των προσομοιώσεων παρουσιάζονται υπό τη μορφή πλημμυρικών χαρτών 

όπως προβλέπεται από την Κοινοτική Οδηγία 2007/60/ΕΚ.      
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Summary  

Flood events are one of the most important natural phenomena with intense and extensive 

environmental, social and economic consequences not only in Greece but also worldwide. In the 

framework of this study we investigated the flood activity of Arachthos River (Epirus, Greece), 

downstream of hydroelectric dam of Pournari. The entire study area is very sensitive, particularly 

because the river crosses the urban area of Arta, which is located just after the dam.     

In this study, two hydraulic models, named HEC-RAS and quasi-2D LISFLOOD, were used to 

simulate flood events and map the resulting flooded areas, assuming in both cases steady flow 

conditions. HEC-RAS model is a 1 dimension hydraulic model, while LISFLOOD-FP, further to 

flood routing in main channel, incorporates methods for the propagation of flood waves across 

flood plains (quasi-2D analysis). Both models require as input elevation data in the form of 

Digital Elevation Model (DEM), which was initially processed in ArcGIS 10.0 suite. The same 

program was also used for the reproduction and presentation of simulation results in the form of 

flood risk maps.         

In this thesis, we studied 4 different flood scenarios, with different likely return period, by 

varying the management of weir system in Pournari dam. More specifically, further to real 

management scenario of flood event of 28-31/12/2005, we examined 3 alternative scenarios that 

result in different peak discharges. These scenarios can be attributed in the lag between the time 

of advent of peak inflow in the dam and the time that the weir system is starting to operate. This 

time lag has as a result the release of different discharge peaks from the weir. Further to that, 

hydraulic simulation was also conducted for the recent flood event of 1/2/2015 assuming an 

estimation of peak discharge, given that real data is not yet available.        

Finally, the hydraulic simulation results are composed and presented in the form of flood risk 

maps aligned with 2007/60/EC Directive for flood management in European Union.      
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Κεφάλαιο 1ο  

1 Εισαγωγή 

1.1 Αντικείμενο της εργασίας 

Στόχος της παρούσας εργασίας είναι η μελέτη ενός ιδιαίτερα συχνού και καταστροφικού 

φυσικού φαινομένου, όπως είναι αυτό της πλημμύρας. Τα διαθέσιμα υδρολογικά και υδραυλικά 

δεδομένα και η ενσωμάτωση αυτών στα υπολογιστικά εργαλεία και λογισμικά καθιστούν δυνατή 

την προσομοίωση του πλημμυρικού φαινομένου με απώτερο στόχο την μελέτη και αξιολόγηση 

της επίδρασης που ασκεί αυτό στον άνθρωπο και τις δραστηριότητές του. Σύμφωνα με την 

κοινοτική οδηγία 2007/60/ΕΚ, η αξιολόγηση αυτή βασίζεται σε τυποποιημένους πλημμυρικούς 

χάρτες επικινδυνότητας και διακινδύνευσης για πλημμύρες διαφορετικών περιόδων επαναφοράς. 

Στον ελληνικό χώρο έχουν διεξαχθεί παρόμοιες μελέτες για διάφορες λεκάνες απορροής 

ποταμών όπως για τον Σπερχειό ποταμό (Σωτηροπούλου, 2012), για την πεδιάδα της Θεσσαλίας 

(Οικονόμου, 2013; Μόσχου, 2014) και για την περιοχή της Ραφήνας (Παγάνα, 2012). Επίσης, 

έχουν πραγματοποιηθεί πλήθος μελετών για τον Άραχθο ποταμό. Έχει πραγματοποιηθεί 

υδρολογική μελέτη πλημμυρών Αράχθου (Κουτσογιάννης κ.α., 2010), προκαταρκτική 

αξιολόγηση κινδύνων πλημμύρας (ΥΠΕΚΑ, 2013) καθώς και μια μελέτη για τον 

επαναπροσδιορισμό της σχέσης της πόλης της Άρτας με τον Άραχθο ποταμό (Μπουλουγούρα 

και Τσώλη, 2012). 

Στην παρούσα εργασία, ως περιοχή μελέτης επιλέχθηκε ο Άραχθος ποταμός, κατάντη του 

υδροηλεκτρικού φράγματος Πουρνάρι Ι, για το μήκος του ποταμού (περίπου 11 km) που 

περικλείει την πόλη της Άρτας. Η μελέτη που παρουσιάζεται στη συνέχεια στηρίζεται σε ένα 

συγκεκριμένο πλημμυρικό γεγονός το οποίο προκλήθηκε από το άνοιγμα του εκχειλιστή του 

φράγματος Πουρνάρι Ι στις 28-31/12/2005. Πέραν του πραγματικού σεναρίου, εξετάζονται και 

δύο εναλλακτικά σενάρια διαχείρισης του εκχειλιστή. Επίσης, πραγματοποιήθηκε υδραυλική 

προσομοίωση για ένα ακόμη σενάριο διαχείρισης του εκχειλιστή κατά την πλημμύρα η οποία 

συνέβη την 1/2/2015. Το τελικό προϊόν της εργασίας είναι πλημμυρικοί χάρτες για τα παραπάνω 

σενάρια και γεγονότα.  
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1.2 Λογισμικά πακέτα και υπολογιστικά εργαλεία 

Στην παρούσα εργασία χρησιμοποιήθηκαν μια σειρά από υπολογιστικά εργαλεία και λογισμικά 

πακέτα αφενός για την επεξεργασία των πρωτογενών δεδομένων και αφετέρου για την εκτέλεση 

των προσομοιώσεων. Η επεξεργασία του ψηφιακού μοντέλου εδάφους της περιοχής μελέτης, 

όπως αυτό λήφθηκε από το Εθνικό Κτηματολόγιο Ελλάδας, έγινε στο ArcGIS 10.0. Το ίδιο 

πακέτο χρησιμοποιήθηκε και για τη δημιουργία του γεωμετρικού αρχείου που απαιτείται για την 

υδραυλική προσομοίωση από το υπολογιστικό πακέτο HEC-RAS 4.0. Στο ίδιο περιβάλλον 

δημιουργήθηκαν και τα αρχεία εισόδου για την υδραυλική προσομοίωση στο LISFLOOD 4.5.0.  

1.3 Κοινοτική οδηγία 2007/60/ΕΚ 

Η κοινοτική οδηγία 2007/60/ΕΚ στοχεύει στην «θέσπιση πλαισίου για την αξιολόγηση και τη 

διαχείριση των κινδύνων πλημμύρας, με στόχο τη μείωση των αρνητικών συνεπειών στην 

ανθρώπινη υγεία, το περιβάλλον, την πολιτιστική κληρονομιά και τις οικονομικές 

δραστηριότητες που συνδέονται με τις πλημμύρες στην Κοινότητα» (Επίσημη Εφημερίδα της 

Κοινότητας, 2007). 

Ως γεωγραφική μονάδα εφαρμογής της Οδηγίας 2007/60/ΕΚ ορίζεται η Περιοχή Λεκάνης 

Απορροής Ποταμού. 

Η οδηγία αποτελείται από 8 κεφάλαια στα οποία παρουσιάζεται ένα ολοκληρωμένο 

καθοδηγητικό πλαίσιο για την εφαρμογή της. Παρακάτω παρουσιάζονται τα βασικά στοιχεία και 

διατάξεις της οδηγίας 2007/60/ΕΚ, όπως δίνονται από την Εφημερίδα της Κυβέρνησης της 

Ελληνικής Δημοκρατίας (2010). 

Κεφάλαιο Ι: Γενικές διατάξεις 

(α) Ως πλημμύρα ορίζεται η προσωρινή κατάκλυση μιας εδαφικής περιοχής με νερό η οποία,  

υπό φυσιολογικές συνθήκες, δεν καλύπτεται από νερό. Τέτοιες πλημμύρες ενδέχεται να 

προκληθούν από ποτάμια, ορεινούς χείμαρρους, εφήμερα ρεύματα ή από την θαλάσσιο 

κυματισμό σε παράκτιες περιοχές.  

(β) Ως κίνδυνος πλημμύρας ορίζεται ο συνδυασμός της πιθανότητας ύπαρξης πλημμύρας και 

των αρνητικών συνεπειών της για την ανθρώπινη υγεία, το περιβάλλον, την πολιτιστική 

κληρονομιά και τις οικονομικές δραστηριότητες οι οποίες συνδέονται με αυτή. 
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(γ) Επικινδυνότητα πλημμύρας είναι η δυνατότητα εμφάνισης πλημμύρας σε συγκεκριμένο 

χώρο, η οποία ποσοτικοποιείται μέσω υδρολογικών ή υδραυλικών μεγεθών (βάθος νερού, 

ταχύτητα ροής) και αντιστοιχεί σε δεδομένη πιθανότητα υπέρβασης. 

Κεφάλαιο ΙΙ : Προκαταρκτική αξιολόγηση των κινδύνων πλημμύρας 

Σκοπός της προκαταρκτικής αξιολόγησης είναι να προσδιοριστούν ζώνες για τις οποίες 

υπάρχουν δυνητικά σοβαροί κίνδυνοι πλημμύρας ή στις οποίες είναι πιθανόν να σημειωθεί 

πλημμύρα («ζώνες δυνητικά υψηλού κινδύνου πλημμύρας»). 

(α) Για κάθε περιοχή λεκάνης απορροής ποταμού απαιτείται προκαταρκτική αξιολόγηση 

κινδύνων πλημμύρας, η οποία βασίζεται κυρίως σε ιστορικές καταγραφές πλημμυρών και 

σε μελέτες-σενάρια για τις μελλοντικές τους επιπτώσεις. 

(β) Στην προκαταρκτική αξιολόγηση περιλαμβάνονται: (α) χάρτες της λεκάνης απορροής με 

τα τοπογραφικά της χαρακτηριστικά και τις χρήσεις γης, (β) περιγραφή των ιστορικών 

πλημμυρών και των αρνητικών επιπτώσεων τους στον άνθρωπο και στις δραστηριότητές 

του, ειδικά για όσες θα μπορούσαν να επαναληφθούν στο μέλλον και θα ήταν δυνατή η 

πρόβλεψη αντίστοιχων σημαντικών αρνητικών συνεπειών. Περιλαμβάνεται τέλος, η 

αξιολόγηση των δυνητικών αρνητικών συνεπειών των μελλοντικών πλημμυρών για τον 

άνθρωπο, λαμβάνοντας υπόψη γενικά υδρολογικά και γεωμορφολογικά χαρακτηριστικά 

όπως η τοπογραφία, η θέση των υδατορρευμάτων, η αποτελεσματικότητα των 

υφιστάμενων αντιπλημμυρικών έργων, η θέση των κατοικημένων περιοχών και των 

περιοχών οικονομικής δραστηριότητας. 

Κεφάλαιο ΙΙΙ : Χάρτες επικινδυνότητας πλημμύρας και χάρτες κινδύνων πλημμύρας 

(α) Στους χάρτες επικινδυνότητας πλημμύρας προσδιορίζονται οι γεωγραφικές ζώνες οι οποίες 

θα μπορούσαν να πλημμυρίσουν από πλημμύρες χαμηλής πιθανότητας υπέρβασης ή 

σενάρια ακραίων φαινομένων (περίοδος επαναφοράς 1000 χρόνια), από πλημμύρες μέσης 

πιθανότητας υπέρβασης (περίοδος επαναφοράς 100 χρόνια) ή από πλημμύρες υψηλής 

πιθανότητας υπέρβασης (περίοδος επαναφοράς 50 χρόνια). Για κάθε πιθανότητα 

πλημμύρας θα πρέπει να καθοριστούν η έκταση της πλημμύρας, τα βάθη ροής ή η απόλυτη 

στάθμη νερού σε χαρακτηριστικές θέσεις, η ταχύτητα ροής και ο χρόνος παραμονής των 

υδάτων σε χαρακτηριστικές θέσεις. 
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(β) Οι χάρτες κινδύνου πλημμύρας διαμορφώνονται ανάλογα με τον αριθμό των κατοίκων, τον 

τύπο των οικονομικών δραστηριοτήτων, την ύπαρξη εγκαταστάσεων οι οποίες ενδέχεται 

να προκαλέσουν ρύπανση, τις προστατευόμενες περιοχές. Σκοπός τους είναι να 

περιγράψουν τις δυνητικές αρνητικές συνέπειες που συνδέονται με τις πλημμύρες.  

1.4 Διάρθρωση εργασίας 

Στο Κεφάλαιο 1 παρατίθενται κάποια εισαγωγικά στοιχεία για το αντικείμενο της εργασίας, τα 

υπολογιστικά εργαλεία που χρησιμοποιήθηκαν και την Κοινοτική Οδηγία 2007/60/ΕΚ. 

Στο Κεφάλαιο 2 παρουσιάζεται αναλυτικά η περιοχή μελέτης και το υδροσύστημα αυτής.  

Στο Κεφάλαιο 3 παρουσιάζεται η διαδικασία υδραυλικής προσομοίωσης στο πακέτο HEC-RAS, 

ενώ στο Κεφάλαιο 4 η αντίστοιχη διαδικασία για το λογισμικό LISFLOOD-FP. 

Τα αποτελέσματα των προσομοιώσεων και η τυποποίηση αυτών υπό μορφή πλημμυρικών 

χαρτών παρουσιάζονται στο Κεφάλαιο 5, ενώ στο Κεφάλαιο 6 αναλύονται τα διάφορα 

πλημμυρικά γεγονότα και σενάρια. 

Τέλος, στο Κεφάλαιο 7 παρουσιάζονται συνοπτικά βασικά γενικά συμπεράσματα, όπως αυτά 

προέκυψαν κατά την σύνταξη της εργασίας. 
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Κεφάλαιο 2ο  

2 H περιοχή μελέτης 

2.1 Υδατικό διαμέρισμα Ηπείρου 

Για την εφαρμογή της οδηγίας 2007/69/ΕΚ στην Ελλάδα, έχουν καθοριστεί 14 περιοχές λεκανών 

απορροής ποταμών. Οι περιοχές αυτές φαίνονται στο Σχήμα 2.1. 

 

Σχήμα 2.1: Απεικόνιση των περιοχών λεκανών απορροής ποταμών στην Ελλάδα και στο υδατικό 
διαμέρισμα Ηπείρου (Πηγή: ΥΠΕΚΑ, 2012) 

Το Υδατικό Διαμέρισμα Ηπείρου (κωδική ονομασία GR05) περιλαμβάνει τις λεκάνες απορροής 

Αώου (GR11), Καλαμά (GR12), Αχέροντα (GR13), Αράχθου (GR14), Λούρου (GR46) και 

Κέρκυρας – Παξών (GR34).  
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2.1.1 Φυσικά χαρακτηριστικά υδατικού διαμερίσματος Ηπείρου 

Το υδατικό διαμέρισμα ηπείρου (GR05) περιλαμβάνει την Περιφέρεια Ηπείρου, μικρά τμήματα 

των Περιφερειών Δυτικής Μακεδονίας και Δυτικής Ελλάδας και τα νησιά Κέρκυρα, Οθωνοί, 

Ερεικούσα, Παξοί και Αντίπαξοι της Περιφέρειας Ιονίων Νήσων. 

Τα γεωγραφικά όρια του Υδατικού Διαμερίσματος Ηπείρου ορίζονται: Νότια από τον 

Αμβρακικό κόλπο, Ανατολικά από τους ορεινούς όγκους Βάλτου, Αθαμανικών, οροσειράς 

βόρειας Πίνδου, Βόιου και Γράμμου, Βόρεια από τα ελληνοαλβανικά σύνορα και Δυτικά από το 

Ιόνιο Πέλαγος. 

Το Υδατικό Διαμέρισμα Ηπείρου έχει έκταση 9.980 km2, και αποτελεί ένα από τα πιο ορεινά 

διαμερίσματα της χώρας (70% ορεινές περιοχές και 15% πεδινές). 

Η γεωγραφική θέση και η πολυμορφία του ανάγλυφου του διαμερίσματος, του προσδίδει μια 

ποικιλία κλιμάτων. Στα νησιά και στις παράκτιες περιοχές επικρατεί θαλάσσιο μεσογειακό κλίμα 

ενώ στο εσωτερικό του διαμερίσματος το κλίμα γίνεται ηπειρωτικό. Ο πιο θερμός μήνας είναι ο 

Αύγουστος και οι πιο ψυχροί ο Ιανουάριος και ο Φεβρουάριος. Το μέσο ετήσιο ύψος βροχής του 

υδατικού διαμερίσματος κυμαίνεται από 1.000 μέχρι 1.200 mm στα παράλια και φτάνει μέχρι τα 

2.000 mm στα ορεινά τμήματα (ΥΠΕΚΑ, 2012). 

2.1.2 Ανθρωπογενή χαρακτηριστικά 

Σύμφωνα με τα απογραφικά στοιχεία της ΕΣΥΕ ο πληθυσμός του υδατικού διαμερίσματος το 

2001 ήταν 464.093 κάτοικοι, αυξημένος κατά 4.1% σε σχέση με αυτόν του 1991. 

Η οικονομία στον πρωτογενή (παραγωγικός τομέας) και δευτερογενή (επεξεργασία και 

μεταποίηση προϊόντων) τομέα παρουσιάζει αρνητική εξέλιξη και θετική στον τριτογενή τομέα 

(τουρισμός). 

Τα συλλογικά αρδευτικά δίκτυα τα οποία έχουν κατασκευαστεί στο υδατικό διαμέρισμα της 

Ηπείρου έχουν έκταση περίπου 410.000 στρέμματα (ΥΠΕΚΑ, 2012). 
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2.1.3 Ζώνες δυνητικά υψηλού κινδύνου πλημμύρας 

Η Ειδική Γραμματεία Υδάτων του Υπουργείου Περιβάλλοντος, Ενέργειας και Κλιματικής 

Αλλαγής πραγματοποίησε την Προκαταρκτική Αξιολόγηση Κινδύνων Πλημμύρας (Preliminary 

Flood Risk Assessment, PFRA) μέσω της οποίας ορίστηκαν οι Ζώνες Δυνητικά Υψηλού 

Κινδύνου Πλημμύρας στο υδατικό διαμέρισμα Ηπείρου. Οι Ζώνες αυτές είναι οι εξής (ΥΠΕΚΑ, 

2013)  

(α) Χαμηλή ζώνη κλειστής λεκάνης Ιωαννίνων (GR05RAK0009) 

(β) Χαμηλή περιοχή άνω ρου του Ποταμού Καλαµά, στην περιοχή ∆ολιανά (GR05RAK0010) 

(γ) Μέσος ρους Καλαμά από το ύψος της Βροσίνας έως το Καστρί (GR05RAK0007) 

(δ) Κάτω ρους - Δέλτα Καλαμά και παράκτια ζώνη Ηγουμενίτσας (GR05RAK0008) 

(ε) Χαμηλές περιοχές λεκάνης Ποταμού Αχέροντα και κλειστής λεκάνης Μαργαριτίου 

(GR05RAK0005) 

(στ) Μέσος ρους Ποταμού Λούρου (GR05RAK0001) 

(ζ) Πεδιάδες Άρτας, χαμηλή ζώνη ποταμών Λούρου - Αράχθου (GR05RAK0003) 

(η) Πεδιάδα Πρέβεζας (GR05RAK0002) 

(θ) Χαμηλή ζώνη νήσου Κέρκυρας από το ύψος της Στρογγυλής μέχρι τους Βιταλάδες 

(GR05RAK0006) 

(ι) Περιοχή Λευκίµµης νήσου Κέρκυρας (GR05RAK0004). 

2.2 Λεκάνη απορροής Αράχθου 

Η λεκάνη απορροής του Αράχθου έχει έκταση 1793.9 km2 ανάντη του φράγματος Πουρναρίου, 

με μέσο υψόμετρο τα 854 m (Κουτσογιάννης κ.α., 2010). 

Ο ποταμός οδεύει μέσω αδιαπέρατων σχηματισμών φλύσχη με αποτέλεσμα να παρατηρούνται 

μεγάλες διακυμάνσεις στην παροχή του. 

Γεωλογική δομή 

Στη λεκάνη απορροής του Αράχθου συναντάμε τους ακόλουθους γεωλογικούς σχηματισμούς: 

Ιόνιος Ζώνη (καλύπτει το μεγαλύτερο τμήμα της λεκάνης απορροής), Ζώνη Γαβρόβου - 

Τρίπολης (καλύπτει μια μικρή περιοχή στο νοτιοανατολικό άκρο) και Ζώνη Πίνδου 

(αναπτύσσεται σε μία μικρή περιοχή ανατολικά της λεκάνης απορροής). 
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Στη λεκάνη απορροής συναντώνται τεταρτογενείς αποθέσεις (αλλουβιακές αποθέσεις, υλικά 

αναβαθμίδων, κώνοι κορημάτων, πλευρικά κορήματα και παράκτιοι σχηματισμοί). 

Υδρογεωλογία περιοχής 

Οι κυριότεροι υδροφόροι απαντώνται στους ανθρακικούς σχηματισμούς της Ιονίου Ζώνης (η 

οποία όπως προαναφέρθηκε καλύπτει το μεγαλύτερο μέρος της λεκάνης). Σημαντικές είναι 

επίσης, οι υδροφορίες των ανθρακικών σχηματισμών των Ζωνών Πίνδου και Γαβρόβου – 

Τρίπολης. Τα ανθρακικά πετρώματα (ασβεστόλιθοι, δολομίτες, ανθρακικά λατυποπαγή και 

κροκαλοπαγή) αποτελούν υδροπερατούς σχηματισμούς, τα οποία λόγω της διάρρηξης και της 

καρστικοποίησής τους, δημιουργούν καρστικούς υδροφόρους μεγάλης δυναμικότητας. Στις 

εμφανίσεις των κοκκωδών τεταρτογενών αποθέσεων (αλλουβιακές αποθέσεις, κορήματα, άμμοι, 

αμμοχάλικα και κροκάλες) συναντώνται υδροφόροι μεγάλης δυναμικότητας, επίσης. Τέλος, η 

παρουσία του φλύσχη (Σχήμα 2.2) δημιουργεί υδροφορίες τοπικής σημασίας και μικρής 

δυναμικότητας, αφού αποτελεί αδιαπέρατο σχηματισμό (Νικολάου, 2005). 
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Σχήμα 2.2: Λεκάνη απορροής Αράχθου (Πηγή: ΥΠΕΚΑ, 2012 ύστερα από επεξεργασία) 
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2.3 Ο Άραχθος ποταμός 

 

Σχήμα 2.3: Ροή του Αράχθου στο σημείο της Γέφυρας της Άρτας 

Ο Άραχθος ποταμός  πήρε το όνομά του από το ρήμα «αράττω», δηλαδή χτυπώ με μεγάλη 

δύναμη (Σχήμα 2.3). Κατά την ελληνική μυθολογία, ο ποτάμιος θεός Άραχθος όταν είδε τα 

αδέλφια του Αχελώος, Αλιάκμονας και Αώος να διαγράφουν την πορεία τους χωρίς εκείνον 

άρχισε να οδεύει προς τον Αμβρακικό κόλπο παρασύροντας ό,τι έβρισκε στο πέρασμά του. Έτσι 

ερμηνεύτηκε η ορμητικότητα των νερών του.  

Ο Άραχθος είναι ο όγδοος μεγαλύτερος ποταμός της Ελλάδας και ένα από τα σημαντικότερα 

ποτάμια της Ηπείρου. Έχει μήκος 110 km. Πηγάζει από το βουνό Λάκμος, νοτιοανατολικά του 

Μετσόβου, στην βόρεια Πίνδο και εκβάλλει τα νερά του στον Αμβρακικό κόλπο. Διαρρέει ένα 

τμήμα του νομού Ιωαννίνων και ολόκληρο τον νομό Άρτας. 

Στον Άραχθο συμβάλλουν οι παραπόταμοι Καλαρρύτικος, Μετσοβίτικος και Ζαγορίτικος. Ο 

Μετσοβίτικος και ο Ζαγορίτικος ποταμός αποτελούν τις δυο πρωταρχικές κοίτες του Αράχθου. 

Για το λόγο αυτό, ο Άραχθος ποταμός είναι γνωστός, από την αρχαιότητα, με την λαϊκή 

ονομασία Διπόταμος. Ο Καλαρρύτικος ποταμός είναι ο κύριος παραπόταμος του Αράχθου. 

Συλλέγει τα νερά των πηγών από τα Τζουμέρκα, τον αυχένα των Μελισσουργών, την 

Κακαρδίτσα και το Περιστέρι και με αυτά τροφοδοτεί τον Άραχθο. Ο Άραχθος και ο 



 

11 
 

Καλαρρύτικος ποταμός αποτελούσαν την συνοριακή γραμμή μεταξύ Ελλάδας και Τουρκίας από 

το 1881 έως το 1912. 

2.4 Υδροσύστημα Αράχθου 

Ο Άραχθος τροφοδοτεί με τα νερά του δύο υδροηλεκτρικά φράγματα, το Πουρνάρι I και το 

Πουρνάρι ΙΙ (Σχήμα 2.4). Το υδροηλεκτρικό συγκρότημα Πουρναρίου I, ξεκίνησε την λειτουργία 

του το 1981 με σκοπό την παραγωγή υδροηλεκτρικής ενέργειας, την άρδευση και την 

αντιπλημμυρική προστασία της πόλης της Άρτας, η οποία περικλείεται από τον Άραχθο (Σχήμα 

2.5). Περιλαμβάνει, ένα συγκρότημα παραγωγής ενέργειας και ένα συγκρότημα εκχειλιστή. Το 

συγκρότημα παραγωγής ενέργειας, αποτελείται από 3 στροβίλους (Francis type turbines) 

συνολικής ισχύος 300 MW και με ετήσια παραγωγή 235 GWh. Έχει μέσο ύψος πτώσης τα 68 m 

και μέγιστη παροχή 500 m3/s. Ο εκχειλιστής, αποτελείται από τρία τοξωτά θυροφράγματα με 

διαστάσεις 12.5 m x 13.5 m και μέγιστη παροχή 3300 m3/s. Το φράγμα είναι χωμάτινο (ύψους 87 

m) και η ωφέλιμη χωρητικότητα του ταμιευτήρα είναι 303 hm3. Η στάθμη του ταμιευτήρα 

κυμαίνεται από τα 100 έως τα 120 m, η οποία είναι και η ανώτατη στάθμη λειτουργίας του 

φράγματος.  

 

Σχήμα 2.4: Απεικόνιση φραγμάτων Αράχθου 
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Σχήμα 2.5: Φράγμα Πουρναρίου I 

Σε περιπτώσεις πλημμύρας, η λειτουργία του εκχειλιστή διέπεται από τους ακόλουθους κανόνες 

(Ν. Μαμάσης, 2014): 

(α) Η λειτουργία εκχείλισης καθίσταται δυνατή μόνο όταν η στάθμη στον ταμιευτήρα ξεπερνά 

τη στέψη του εκχειλιστή (107.5 m) και η παροχή εισροής ξεπερνά την παροχετευτικότητα 

του σταθμού παραγωγής ενέργειας (500 m3/s ή 1.8 hm3/hr). 

(β) Σε μια μέτρια πλημμύρα, όταν η στάθμη του ταμιευτήρα είναι ή φτάνει στα 120 m, η 

παροχή εκροής θα πρέπει να είναι ίση με την παροχή εισροής (ώστε η στάθμη να 

παραμένει στα 120 m) και αυτό επιτυγχάνεται με τον χειρισμό του ανοίγματος των 

θυροφραγμάτων.  

(γ) Σε μια μεγαλύτερη πλημμύρα, όπου το άνοιγμα των θυροφραγμάτων έχει φτάσει τα 8 m 

και η στάθμη στον ταμιευτήρα τείνει να ανυψωθεί άνω των 120 m, τότε πραγματοποιείται 

πλήρες άνοιγμα των θυροφραγμάτων (η αντιμετώπιση της πλημμύρας σχεδιασμού πάντως 

θεωρείται ότι γίνεται μόνο με τον εκχειλιστή, ότι δηλαδή δεν λειτουργεί παράλληλα και ο 

σταθμός παραγωγής). 

(δ) Όταν η στάθμη του ταμιευτήρα είναι στα 120 m και τα θυροφράγματα είναι πλήρως 

ανοιχτά, ο εκχειλιστής παροχετεύει περίπου 3300 m3/s ή 11.9 hm3/hr. Υποθέτοντας την 
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παράλληλη λειτουργία  των στροβίλων στη μέγιστη δυνατότητά τους, η παροχή κατάντη 

του φράγματος ανέρχεται στα 3800 m3/s ή 13.7 hm3/hr. Το ίδιο μέγεθος της φυσικής 

παροχής του Αράχθου αντιστοιχεί σε περίοδο επαναφοράς περίπου 70 ετών (η πλημμύρα 

των 100 ετών έχει αιχμή 4050 m3/s). 

(ε) Αν η παροχή εισροής ξεπεράσει τα 3800 m3/s, η στάθμη νερού στον ταμιευτήρα θα 

ανεβαίνει, ακόμη και με πλήρως ανοιχτά θυροφράγματα. Σημειώνεται ότι η στέψη του 

φράγματος είναι στα 128 m και η ανώτατη στάθμη πλημμύρας στα 125,8 m (περιθώριο 

ασφάλειας 2,2 m). 

(στ) Μετά την υποχώρηση της πλημμύρας (καθοδικός κλάδος) και αντίστοιχα την ταπείνωση 

της στάθμης κάτω από τα 120 m, τα θυροφράγματα αρχίζουν να κλείνουν, αρχικώς στα 8 

m και στη συνέχεια βαθμιαία σε μικρότερα ανοίγματα.  

Το δεύτερο υδροηλεκτρικό φράγμα του Αράχθου, Πουρνάρι ΙΙ κατασκευάστηκε για την 

παραγωγή υδροηλεκτρικής ενέργειας και άρδευση (Σχήμα 2.6). Η έναρξη της λειτουργίας του 

πραγματοποιήθηκε το 1998, περιλαμβάνει τρείς στροβίλους συνολικής ισχύος 33.6 MW (2 x 16 

bulb και 1 x 1.6 S type units) και μέσης ετήσιας παραγωγής 45 GWS. Το φράγμα είναι χωμάτινο 

(ύψους 15 m) και η ωφέλιμη χωρητικότητα του ταμιευτήρα είναι 4 hm3 (Αργυράκης, 2010). 

 

Σχήμα 2.6: Φράγμα Πουρναρίου ΙΙ 

Τέλος, σε απόσταση 2 km ανάντη της Γέφυρας της Άρτας υπάρχει φράγμα υδροληψίας για 

αρδευτικούς σκοπούς, με το όνομα Ιμαρέτ. 



 

14 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

15 
 

Κεφάλαιο 3ο  

3 Υδραυλική προσομοίωση μέσω HEC-RAS  

3.1 Θεωρητική τεκμηρίωση για την επίλυση μόνιμης ροής στο HEC-RAS 

Η παρούσα ενότητα παρουσιάζει τη μεθοδολογία επίλυσης που ενσωματώνει το HEC-RAS για 

την μόνιμη ροή σε μια διάσταση. Οι ενότητες που ακολουθούν έχουν ληφθεί από το εγχειρίδιο 

χρήσης του προγράμματος και παρατίθενται για λόγους πληρότητας της εργασίας (Bruner, 

2010a, 2010b). 

Οι υποθέσεις που ενσωματώνονται από το μοντέλο και καθορίζουν τις αναλυτικές εξισώσεις που 

χρησιμοποιούνται και περιγράφονται στην παρούσα ενότητα, είναι: 

(α) Ύπαρξη μόνιμης ροής 

(β) Σταδιακά και ομαλά μεταβαλλόμενη ροή. Στην περίπτωση ύπαρξης υδραυλικών 

κατασκευών που προκαλούν γρήγορη μεταβολή της ροής (π.χ. γέφυρες, οχετοί, 

υπερχειλιστές και ιχθυοφραγμοί) γίνεται χρήση της εξίσωσης διατήρησης της ορμής ή 

άλλων εμπειρικών σχέσεων (βλ. Ενότητα 3.1.8).   

(γ) Η ροή γίνεται σε μια διάσταση (οι συνιστώσες της ταχύτητας σε άλλες διευθύνσεις δεν 

λαμβάνονται υπόψη) 

(δ) Τα κανάλια των ποταμών έχουν μικρή κλίση, μικρότερη από 1:10. 

Η ελεύθερη επιφάνεια του ποταμιού, για μόνιμη ροή και σε μια διάσταση, υπολογίζεται από 

διατομή σε διατομή μέσω της εξίσωσης διατήρησης της ενέργειας, χρησιμοποιώντας μια 

επαναληπτική διαδικασία. Η εξίσωση διατήρησης της ενέργειας μεταξύ των διατομών 2 (ανάντη) 

και 1 (κατάντη) θα δίνεται από τη σχέση: 

 
2 2

2 2 1 1
2 2 1 12 2 e

V V
h

g g

 
           (4.1) 

 Όπου: Ζ1, Ζ2: τα υψόμετρα του κυρίως καναλιού; Υ1, Υ2: το βάθος νερού στις διατομές, V1, V2: οι 

μέσες ταχύτητες ροής (συνολική παροχή / συνολική βρεχόμενη περιοχή) στις διατομές; α1, α2: οι 
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συντελεστές συνόρθωσης ταχύτητας της κινητικής ενέργειας; g: η επιτάχυνση της βαρύτητας; he 

ολικές απώλειες ενέργειας (γραμμικές και τοπικές).      

Στο Σχήμα που ακολουθεί φαίνονται γραφικά οι όροι της κινητικής ενέργειας (Σχήμα 3.1). 

 

Σχήμα 3.1: Γραφική αναπαράσταση των όρων της εξίσωσης ενέργειας (Πηγή: Bruner, 2010a) 

Από την παραπάνω εξίσωση, γίνεται εμφανής η υπόθεση μόνιμης ροής καθώς όλοι οι όροι είναι 

ανεξάρτητοι του χρόνου t. Επίσης, η ροή θεωρείται ομαλά μεταβαλλόμενη καθώς η εξίσωση 

βασίζεται στην υπόθεση ύπαρξης υδροστατικής πίεσης σε κάθε διατομή. Η υπόθεση για μικρή 

κλίση που δεν υπερβαίνει την αναλογία 1:10 βασίζεται στο γεγονός ότι από την παραγώγιση της 

εξίσωσης ενέργειας η κατακόρυφη πίεση, Hp, είναι: 

 cospH d    (4.2) 

όπου d το βάθος νερού μετρούμενο από τον πυθμένα του καναλιού και θ η κλίση του πυθμένα σε 

βαθμούς. Για κλίση 1:10, το συνημίτονο είναι ίσο με 0.995. Συνεπώς, ο όρος cosθ μπορεί να 

απαλειφθεί χωρίς το σφάλμα που επιφέρει αυτή η αλλαγή να είναι μεγάλη.      

Το συνολικό ύψος των απωλειών (he) μεταξύ δυο διαδοχικών διατομών αποτελείται από τις 

γραμμικές απώλειες λόγω τριβής (πρώτος όρος αθροίσματος) και τις απώλειες λόγω 

συστολής/διαστολής (δεύτερος όρος αθροίσματος). Η εξίσωση που δίνει το συνολικό ύψος 

απωλειών μεταξύ δυο διατομών, 1 και 2, είναι η εξής: 
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2 2

2 2 1 1

2 2e f

V V
h LS C

g g

 
     (4.3) 

όπου L η μέση σταθμισμένη απόσταση μεταξύ των δυο διατομών, fS  η κλίση τριβών μεταξύ δυο 

διατομών και C ο συντελεστής συστολής/διαστολής. Λεπτομέρειες για τον υπολογισμό των όρων 

της εξίσωσης απωλειών δίνονται στις Ενότητες 3.1.4 και 3.1.5.  

Η μέση σταθμισμένη απόσταση μεταξύ των διατομών υπολογίζεται ως εξής: 

 lob lob ch ch rob rob

lob ch rob

L Q L Q L Q
L

Q Q Q

 


 
  (4.4) 

Όπου Llob, Lch, Lrob οι αποστάσεις των διατομών κατά μήκος της διεύθυνσης ροής στο αριστερό 

τμήμα, στην κοίτη και στο δεξί τμήμα, αντίστοιχα, και ,  ,  lob ch robQ Q Q  οι μέσες παροχές των 

διατομών στο δεξί τμήμα, στην κοίτη και στο αριστερό τμήμα, αντίστοιχα.  

3.1.1 Υποδιαίρεση διατομών για τον υπολογισμό συντελεστή μεταφοράς 

Ο προσδιορισμός του συντελεστή μεταφοράς καθώς και του συντελεστή ταχύτητας σε μια 

διατομή απαιτεί την υποδιαίρεση της ροής σε επί μέρους τμήματα ώστε να θεωρήσουμε 

ομοιόμορφα κατανεμημένη ταχύτητα σε κάθε διατομή. Αρχικά, η χονδροειδής υποδιαίρεση της 

κάθε διατομής γίνεται θεωρώντας δυο πλευρικά τμήματα (πέραν της αριστερής και δεξιάς όχθης) 

και το τμήμα της κοίτης. Σε κάθε ένα από αυτά τα τμήματα ο συντελεστής Manning θεωρείται 

σταθερός και ενιαίος για όλο το τμήμα. Φυσικά, το πρόγραμμα επιτρέπει την περεταίρω 

υποδιαίρεση των τμημάτων σε μικρότερα κομμάτια με πιο κοντινούς συντελεστές Manning. Σε 

κάθε τμήμα, ο συντελεστής μεταφοράς υπολογίζεται από τις παρακάτω εξισώσεις: 

 1/2
fQ KS   (4.5) 

 2/31.486
K AR

n
   (4.6) 

Όπου Κ ο συντελεστής μεταφοράς, Α εμβαδόν βρεχόμενης διατομής, n ο συντελεστής 

τραχύτητας Manning και R η υδραυλική ακτίνα (εμβαδόν διατομής/βρεχόμενη περίμετρος).       
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Το πρόγραμμα αθροίζει τους επί μέρους συντελεστές για όλα τα τμήματα στις όχθες 

υπολογίζοντας τελικά τους όρους Κlob και Krob. Το ίδιο συμβαίνει και για το τμήμα της κοίτης 

(Kch). Τελικά, ο συντελεστής μεταφοράς όλης της διατομής, Kch, προκύπτει ως το άθροισμα: 

 lob ch robK K K K     (4.7) 

Η μέθοδος διαίρεσης των διατομών για τον υπολογισμό του συντελεστής μεταφοράς που 

υιοθετεί το HEC-RAS δίνεται στο Σχήμα 3.2. 

 

Σχήμα 3.2: Μέθοδος υποδιαίρεσης διατομής σε επί μέρους τμήματα (Πηγή: Bruner, 2010a) 

3.1.2 Υπολογισμός συντελεστή Manning στην κοίτη 

Γενικά. η κοίτη του ποταμού δεν υποδιαιρείται σε επί μέρους τμήματα, εκτός και αν ο 

συντελεστής τραχύτητας n μεταβάλλεται έντονα εντός της κοίτης. Το πρόγραμμα ελέγχει αν ένας 

τέτοιος διαχωρισμός έχει νόημα, και αν όχι, υπολογίζεται ένας και μοναδικός συντελεστής για 

όλη την περιοχή. Το κριτήριο που χρησιμοποιείται ελέγχει αν η κλίση είναι μεγαλύτερη από την 

αναλογία 5 (οριζόντια διάσταση) : 1 (κατακόρυφη διάσταση) και το εν λόγω τμήμα έχει 

παραπάνω από έναν συντελεστές τραχύτητας. Η κλίση υπολογίζεται ως η οριζόντια απόσταση 

μεταξύ των παρακείμενων, εντός της κοίτης σημείων (n-values), προς την υψομετρική τους 

διαφορά. Σε αυτή την περίπτωση ο συντελεστής τραχύτητας nc θα δίνεται από τη σχέση (Chow, 

1959): 
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2/3

1.5

1

( )
N

i i
i

c

Pn
n

P


 
 
 
 
  


  (4.8) 

όπου nc ο ενιαίος συντελεστής τραχύτητας, P η βρεχόμενη περίμετρος ολόκληρης της διατομής, 

Pi η βρεχόμενη περίμετρος του τμήματος i και ni ο συντελεστής τραχύτητας για το τμήμα i.      

Αξίζει να αναφέρουμε πως το HEC-RAS τονίζει την ανάγκη ελέγχου των αποτελεσμάτων που 

προκύπτουν από την παραπάνω σχέση για την λογική ορθότητά τους.   

3.1.3 Υπολογισμός μέσης κινητικής ενέργειας στη διατομή 

Η κινητική ενέργεια στη μονοδιάστατη ανάλυση που εκτελεί το HEC-RAS προκύπτει ως μια 

σταθμισμένη μέση ενέργεια των τριών τμημάτων της διατομής (αριστερό τμήμα, κοίτη, δεξί 

τμήμα). Το Σχήμα που ακολουθεί απεικονίζει τον τρόπο υπολογισμού της μέσης κινητικής 

ενέργειας σε διατομή με κοίτη και δεξί τμήμα (Σχήμα 3.3).  

 

Σχήμα 3.3: Τρόπος υπολογισμού συνολικής κινητικής ενέργειας διατομής με κοίτη και δεξί τμήμα (Πηγή: 
Bruner, 2010a) 

Η μέση κινητική ενέργεια για την παραπάνω διατομή θα δίνεται από τη σχέση: 

 

2 2
1 2

1 22

1 2

2 2
2

V V
Q Q

V g g
g Q Q







  (4.9) 



 

20 
 

όπου V1, V2 οι ταχύτητες ροής στο τμήμα 1 και 2, αντίστοιχα, Q1, Q2  οι παροχές στο τμήμα 1 και 

2 αντίστοιχα, V  η μέση ταχύτητα ροής όλης της διατομής και α ο συντελεστής συνόρθωσης της 

κινητικής ενέργειας.   

Ο συντελεστής συνόρθωσης κινητικής ενέργειας της διατομής του παραπάνω σχήματος (Σχήμα 

3.3), α, προκύπτει από την παραπάνω σχέση ως εξής:  

 

2 2
1 2

1 2 2 2
1 1 2 2

2 2
1 2 1 2

2
2 2

( ) ( )

V V
g Q Q

g g QV Q V

Q Q V Q Q V


 
    

 
  (4.10) 

Στη γενική περίπτωση που η διατομή έχει χωριστεί σε Ν τμήματα, ο συντελεστής α θα δίνεται 

από τη σχέση: 

 
2 2 2

1 1 2 2
2

1 2

...

( ...Q )
N N

N

QV Q V Q V

Q Q V
   


 
  (4.11) 

3.1.4 Υπολογισμός απωλειών λόγω τριβής 

Όπως περιγράφετε στην Ενότητα 3.1, οι συνολικές απώλειες της ροής δίνονται από τη σχέση 

(4.3). Ο πρώτος όρος της σχέσης αυτής αποδίδει τις απώλειες λόγω τριβών: 

 fe fh S L   (4.12) 

όπου L μέση σταθμισμένη απόσταση μεταξύ των διατομών (4.4) και fS  η κλίση τριβών μεταξύ 

δυο διατομών.  

Η κλίση των τριβών (κλίση γραμμής ενέργειας κάθε διατομής) θα δίνεται από την εξίσωση 

Manning: 

 
2

f

Q
S

K
   
 

  (4.13) 

Το πρόγραμμα παρέχει τους εξής εναλλακτικούς τρόπους υπολογισμού της κλίσης τριβών 

μεταξύ δυο διατομών 1 και 2: 



 

21 
 

Εξίσωση Μέσης Μεταφοράς 

 

2

1 2

1 2
f

Q Q
S

K K

 
   

  (4.14) 

Εξίσωση Μέσης Κλίσης Τριβών 

 1 2

1 2
f

Q Q
S

K K





  (4.15) 

Εξίσωση Μέσης Γεωμετρικής Κλίσης Τριβών 

 1 2f f fS S S   (4.16) 

Εξίσωση Μέσης Αρμονικής Κλίσης Τριβών 

 1 2

1 2

2( )f f
f

f f

S S
S

S S



  (4.17) 

όπου Q1, Q2 οι παροχές των δυο διατομών και Κ1, Κ2 οι συντελεστές μεταφοράς των δυο 

διατομών.  

Το πρόγραμμα υιοθετεί σαν προτιμότερη επιλογή την εξίσωση (4.13). 

3.1.5 Υπολογισμός τοπικών απωλειών 

Οι απώλειες λόγω συστολής/διαστολής, hce, μεταξύ δυο διατομών 1 και 2 υπολογίζονται από την 

ακόλουθη σχέση: 

 
2 2

1 1 2 2

2 2ce

aV a V
h C

g g
    (4.18) 

όπου C ο συντελεστής συστολής/διαστολής για τοπικές απώλειες, V1, V2 οι ταχύτητες ροής των 

δυο διατομών και α1, α2  οι συντελεστές συνόρθωσης της κινητικής ενέργειας σε δυο διατομές.  

Το πρόγραμμα θεωρεί απώλειες λόγω διαστολής όταν η κινητική ενέργεια είναι μεγαλύτερη στα 

κατάντη σε σχέση με τα ανάντη, και κατάσταση συστολής στην αντίθετη περίπτωση.  
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3.1.6 Επαναληπτική διαδικασία επίλυσης της εξίσωσης ενέργειας 

Η εύρεση της επιφάνειας του ποταμιού γίνεται μέσω της επίλυσης των σχέσεων που δίνονται 

στην Ενότητα 3.1. Ωστόσο, το σύστημα εξισώσεων δεν επιλύεται άμεσα και συνεπώς απαιτείται 

μια επαναληπτική διαδικασία δοκιμών. Η υπολογιστική διαδικασία που ακολουθείται 

περιγράφεται από τα παρακάτω βήματα: 

(α) Υποθέτουμε ένα αρχικό ύψος της ελεύθερης επιφάνειας στην ανάντη διατομή (ή στην 

κατάντη διατομή αν η ροή είναι υπερκρίσιμη) 

(β) Υπολογίζεται ο συνολικός συντελεστής Κ της διατομής και οι ταχύτητες ροής. 

(γ) Υπολογίζεται η μέση κλίση τριβών fS  και επιλύεται η εξίσωση (4.2). 

(δ) Μέσω της εξίσωσης (4.1) υπολογίζεται η νέα στάθμη της επιφάνειας νερού. 

(ε) Συγκρίνεται η νέα επιφάνεια με αυτή που υποθέσαμε στο Βήμα (α). Η διαδικασία 

επαναλαμβάνεται μέχρι η απόκλιση της νέας με την προηγούμενη επιφάνεια να γίνει 

μικρότερη από 0.003 m ή της τιμής ανοχής που έχει θέσει ο χρήστης.  

Σε κάθε επανάληψη το κριτήριο για την επιλογή του αρχικού υψομέτρου μεταβάλλεται. Στην 

πρώτη επανάληψη, το υποτιθέμενο υψόμετρο βασίζεται στην προβολή του βάθους νερού της 

προηγούμενης διατομής στην υπό μελέτη. Στη δεύτερη, το υψόμετρο τίθεται ίσο με το αρχικό 

συν το 70% του σφάλματος από την πρώτη επανάληψη (υπολογισμένο – υποτιθέμενο βάθος). 

Από την τρίτη επανάληψη και μετά το υποτιθέμενο βάθος δίνεται από την εξίσωση: 

 2 1 2 *( _ / _ )I IWS WS Err Err Assum Err Diff     (4.19) 

όπου WSI η νέα στάθμη που υποθέτουμε, WSI-1 η στάθμη που υποθέσαμε στην προηγούμενη 

επανάληψη, WSI-2 η στάθμη που υποθέσαμε δυο επαναλήψεις πριν, Err1-2   το σφάλμα μεταξύ τα 

των υποτιθέμενων και τελικών υψομέτρων της Ι-2 επανάληψης, Err_Assum η απόκλιση μεταξύ 

των υψομέτρων που υπολογίστηκαν κατά τις δυο τελευταίες επαναλήψεις (WSI-1 - WSI-2) και 

Err_Diff η διαφορά μεταξύ της υποτιθέμενης στάθμης μείων της υπολογισμένης από την 

προηγούμενη επανάληψη συν το σφάλμα Err1-2.  

Το πλήθος επαναλήψεων που υιοθετεί το πρόγραμμα είναι ίσο με 20, ωστόσο μπορεί να 

αλλαχθεί από τον χρήστη. Για να εξασφαλιστεί η σύγκλιση της παραπάνω μεθόδου το 

πρόγραμμα ενσωματώνει διάφορους περιορισμούς και κατώφλια. Για παράδειγμα, η μεταβολή 
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του βάθους που τίθεται αρχικά σε κάθε επανάληψη δεν μπορεί να είναι μεγαλύτερη από 50%. 

Επιπλέον, όταν ο όρος Err_Assum γίνει μικρότερος από 0.002, η εξίσωση (4.18) παύει να 

χρησιμοποιείται και το βάθος που τίθεται είναι ίσο με τη μέση τιμή του υποτιθέμενου και 

υπολογισμένου βάθους της προηγούμενης επανάληψης.    

Κατά την εκτέλεση της επαναληπτικής διαδικασίας, το πρόγραμμα καταγράφει και 

παρακολουθεί τις επιφάνειες νερού στις οποίες ελαχιστοποιείται το σφάλμα μεταξύ υποτιθέμενης 

και υπολογισμένης στάθμης. Αυτές οι στάθμες καλούνται επιφάνειες ελάχιστου σφάλματος. Εάν 

στα πλαίσια της επαναληπτικής διαδικασίας δεν βρεθεί επιφάνεια ελάχιστου σφάλματος, τότε το 

πρόγραμμα εκτιμά το κρίσιμο βάθος ροής (βλ. Ενότητα 3.1.7). Εν συνεχεία ελέγχεται αν το 

ελάχιστο σφάλμα βρίσκεται εντός κάποιων ορίων ανοχής (0.1 m). Εάν ισχύει κάτι τέτοιο και το 

καθεστώς ροής είναι ίδιο με αυτό που έχει υποτεθεί (έλεγχος με κρίσιμο βάθος ροής) τότε η 

επιφάνεια που έχει βρεθεί γίνεται δεκτή. Αντίθετα, σε περίπτωση που το ελάχιστο σφάλμα 

υπερβαίνει το κριτήριο ανοχής ή το καθεστώς ροής δεν είναι αυτό που έχει υποτεθεί, το 

πρόγραμμα υιοθετεί το κρίσιμο βάθος σαν απάντηση για την διατομή.  

Για να ελέγξει την ύπαρξη υποκρίσιμης ροής το πρόγραμμα χρησιμοποιεί τον αριθμό Froude. 

Συγκεκριμένα, υπολογίζεται ξεχωριστά ο αριθμός Froude για την κοίτη του ποταμού και για όλη 

τη διατομή. Εάν και οι δυο αριθμοί Froude βρεθούν μεγαλύτεροι από 0.94 τότε το πρόγραμμα 

προσπαθεί να προσδιορίσει λεπτομερέστερα το καθεστώς ροής, υπολογίζοντας ακριβέστερα το 

κρίσιμο βάθος της διατομής, με χρήση επαναληπτικής διαδικασίας (βλ. Ενότητα 3.1.7). Για 

διατομές με υπερκρίσιμη ροή, το κρίσιμο βάθος έχει υπολογιστεί λεπτομερώς εξ αρχής.    

3.1.7 Προσδιορισμός κρίσιμου βάθους 

Το κρίσιμο βάθος μιας διατομής προσδιορίζεται από το πρόγραμμα στις παρακάτω περιπτώσεις: 

(α) Έχει καθοριστεί (βρεθεί) καθεστώς υπερκρίσιμης ροής. 

(β) Ο υπολογισμός ζητείται από τον χρήστη. 

(γ) Η επαναληπτική διαδικασία επίλυσης της εξίσωσης ενέργειας δεν μπορεί να συγκλίνει στα 

πλαίσια του μέγιστου επιτρεπτού αριθμούς επαναλήψεων (βλ. Ενότητα 3.1.6). 

(δ) Ο έλεγχος με χρήση του αριθμού Froude για την ύπαρξη υποκρίσιμης ροής απαιτεί την 

εκτίμηση του κρίσιμου βάθους ροής.  
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Η ενέργεια μιας διατομής δίνεται από τη σχέση: 

 
2

2

aV
H WS

g
    (4.20) 

όπου Η η συνολική ενέργεια, WS το υψόμετρο της επιφάνειας και τέλος ο όρος της κινητικής 

ενέργειας. Το κρίσιμο βάθος ροής είναι αυτό που η συνολική ενέργεια γίνεται ελάχιστη για 

δεδομένη ροή και διατομή. Το βάθος αυτό υπολογίζεται μέσω μιας υπολογιστικής διαδικασίας 

σύμφωνα με την οποία τίθενται διάφορες τιμές WS και υπολογίζεται η ενέργεια από την εξίσωση 

(4.19), μέχρι την εύρεση της ελάχιστης.  

Εκτός της επαναληπτικής μεθόδου, το HEC-RAS ενσωματώνει και μια μέθοδο παρεμβολής 

παραβολής (“parabolic” method). Η μέθοδος παραβολής είναι ταχύτερη από την επαναληπτική 

αλλά μπορεί να αποδώσει μόνο μια ενέργεια σε κάθε διατομή (αυτό συμβαίνει στην πλειονότητα 

των διατομών). Εάν η σύγκλιση της μεθόδου αποτύχει, τότε χρησιμοποιείται η επαναληπτική 

διαδικασία. Η επαναληπτική διαδικασία είναι προτιμότερη για διατομές με περισσότερα του ενός 

ελάχιστα στην καμπύλη ενέργειας (Σχήμα 3.4). Πολλαπλά ελάχιστα εμφανίζονται συνήθως σε 

διατομές με πολύ πλατιές και επίπεδες όχθες, καθώς και σε διατομές με αναχώματα ή/και 

περιοχές ανενεργούς ροής. Περισσότερα στοιχεία για την επαναληπτική διαδικασία εύρεσης 

πολλαπλών ελαχίστων δίνονται στο εγχειρίδιο του HEC-RAS (Bruner, 2010a, 2010b).     
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Σχήμα 3.4: Διάγραμμα συνολικής H – στάθμης WS. Το βάθος Hmin για το οποίο η ενέργεια γίνεται 
ελάχιστη, WScrit, ονομάζεται κρίσιμο (Πηγή: Bruner, 2010a) 

3.1.8 Χρήση εξίσωσης διατήρησης της ορμής. 

Στις περιπτώσεις που έχουμε εναλλαγή της ροής από υποκρίσιμη σε υπερκρίσιμη ή το ανάποδο, 

η ροή παύει να θεωρείται ομαλά μεταβαλλόμενη και η εξίσωση ενέργειας (4.1) δεν μπορεί να 

χρησιμοποιηθεί. Αυτή η περίπτωση είναι συνήθης σε απότομες εναλλαγές της κλίσης του 

ποταμιού, σε συμβολές ποταμών ή σε υδραυλικές κατασκευές που επηρεάζουν έντονα τη ροή. Σε 

αυτές τις περιπτώσεις γίνεται χρήση είτε της εξίσωσης διατήρησης της ορμής είτε άλλων 

εμπειρικών σχέσεων. 

Η εξίσωση διατήρησης της ορμής βασίζεται στον δεύτερο νόμο του Νεύτωνα: 

 xF ma   (4.21) 

όπου m η μάζα και α η επιτάχυνση. 

Εφαρμόζοντας τον παραπάνω νόμο σε ένα υδάτινο σώμα που περιορίζεται από δυο διατομές 1 

και 2 (Σχήμα 3.5), προκύπτει η παρακάτω εξίσωση μεταβολής της ορμής στη μονάδα του χρόνου 

(4.22). 
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 2 1 x f xP P W F Q V       (4.22) 

όπου P2, P1 η υδροστατική πίεση στις διατομές 1 και 2, Wx οι βαρυτικές δυνάμεις στη διεύθυνση 

x, Ff οι δυνάμεις τριβής λόγω της κίνησης του νερού από τη διατομή 2 στην 1, Q η παροχή, ρ η 

πυκνότητα του νερού και ΔVx η μεταβολή στην ταχύτητα από τη διατομή 2 στην 1.   

 

Σχήμα 3.5: Εφαρμογή της αρχής διατήρησης της ορμής σε υδάτινο σώμα (Πηγή: Bruner, 2010a) 

Τελικά η εξίσωση που χρησιμοποιείται από το HEC-RAS για απότομα μεταβαλλόμενες ροές 

είναι η εξής: 

 
2 2
2 2 1 2 1 2 1 1

2 2 0 1 1
2 12 2 f

Q A A A A Q
A Y LS LS AY

gA gA

            
   

  (4.23) 

όπου Q η παροχή, g η επιτάχυνση της βαρύτητας, Ai η βρεχόμενη επιφάνεια, iY  το βάθος 

μετρούμενο από την επιφάνεια μέχρι το κεντροειδές της περιοχής που ορίζουν οι διατομές 1 και 

2, L η απόσταση μεταξύ των δυο διατομών στο άξονα των x και fS η κλίση της γραμμής 

ενέργειας. 
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3.2 Επεξεργασία γεωμετρικού αρχείου 

Ως αρχικό δεδομένο, για την υδραυλική προσομοίωση του ποταμού, διαθέτουμε το ψηφιακό 

μοντέλο εδάφους (DEM). Χρησιμοποιώντας την εργαλειοθήκη HEC-GeoRAS εξάγουμε το 

γεωμετρικό αρχείο. Το γεωμετρικό αρχείο περιλαμβάνει, την κύρια γραμμή ροής, τις όχθες, την 

διεύθυνση ροής, τις διατομές καθώς και τις χρήσεις γης κατά μήκος του ποταμού. 

Το εν λόγω γεωμετρικό αρχείο εισάγεται στο HEC-RAS. Εισάγουμε επίσης, τις πλημμυρικές 

αιχμές, οι οποίες έχουν προκύψει από την μελέτη της διαχείρισης του υδροσυστήματος του 

Αράχθου κατά την υφιστάμενη πλημμύρα στις 28-31/12/2005 (Μαμάσης, 2014). Καθορίζουμε 

επίσης, τις οριακές συνθήκες, οι οποίες απαιτούνται από το HEC-RAS για την επεξεργασία των 

δεδομένων εισόδου και την εξαγωγή των πιεζομετρικών γραμμών και των γραμμών ενέργειας, 

για όλο το μήκος του ποταμού το οποίο μελετάται. Η πορεία της υδραυλικής προσομοίωσης 

περιγράφεται σχηματικά στο Σχήμα 3.6.  

 

Σχήμα 3.6: Πορεία υδραυλικής προσομοίωσης στο HEC-RAS 
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Για την δημιουργία του γεωμετρικού αρχείου, το οποίο αποτελεί το βασικό αρχείο εισόδου στο 

HEC-RAS χρησιμοποιούμε την εργαλειοθήκη του GIS, HEC-GeoRAS. Η πρόσβαση στην 

εργαλειοθήκη γίνεται μέσω των εντολών “Customize → Toolbars → HEC-GeoRAS”. 

3.2.1 Εισαγωγή του DEM στο ArcMap 

Στο περιβάλλον του ArcMap και ειδικότερα σε αυτό του GIS εισάγουμε το ψηφιακό μοντέλο 

εδάφους (DEM). Πιο συγκεκριμένα, αποκαθίσταται η σύνδεση με τον φάκελο στον οποίο 

περιέχεται το DEM, μέσω της πορείας “Windows → Catalog → Connect To Folder” και έπειτα 

εισάγεται το DEM, μέσω των εντολών “Customize → Toolbars → Standard → Add Data”. 

3.2.2 Δημιουργία τριγωνικού δικτύου TIN 

Αρχικά, γίνεται η παραγωγή των ισοϋψών καμπυλών σε περιβάλλον GIS, ακολουθώντας τις 

εντολές “Spatial Analyst Tools → Surface → Contour” με ισοδιάσταση ισοϋψών 10 m. 

Πραγματοποιείται, επίσης, η δημιουργία του τριγωνικού δικτύου TIN, με χρήση των εντολών 

“3D Analyst tools → Conversion → From Raster → Raster to TIN”, όπως φαίνεται στο Σχήμα 

3.7. Στο παράθυρο διαλόγου εισάγουμε το Raster και την ισοδιάσταση 10 m.  

Μπορούμε να επέμβουμε στα Layers τα οποία δημιουργούνται και εμφανίζονται στο παράθυρο 

“Table Of Contents” κάνοντας δεξί κλικ και επιλέγοντας “Properties”. Η καρτέλα η οποία 

εμφανίζεται μας παρέχει πληροφορίες για την πηγή του συγκεκριμένου Layer και μας επιτρέπει 

να το μετονομάσουμε, να τροποποιήσουμε τους συμβολισμούς του κ.α.. 
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Σχήμα 3.7: Απεικόνιση τριγωνικού δικτύου TIN 

3.2.3 Δημιουργία θεματικών επιπέδων 

Τα θεματικά επίπεδα τα οποία πρέπει να οριστούν είναι: η κύρια γραμμή ροής του ποταμού, οι 

όχθες, η κύρια διεύθυνση ροής, οι διατομές και οι χρήσεις γης. Όπως προαναφέρθηκε, το βασικό 

εργαλείο για την δημιουργία τους είναι το HEC-GeoRAS. Από την εντολή “RAS Geometry → 

Create RAS Layers” δημιουργούμε τα Layers του Stream Centerline, Bank Lines, Flow Path 

Centerlines,  XS Cut Lines και Landuse Areas (βλ. Σχήμα 3.8). Το κάθε Layer αναλύεται στη 

συνέχεια. 
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Σχήμα 3.8: Δημιουργία των Layers των θεματικών επιπέδων 

(α) Κύρια γραμμή ροής (Stream Centerline) 

Η κύρια γραμμή ροής ψηφιοποιείται με την βοήθεια του “Editor”, στο περιβάλλον του GIS, 

σύμφωνα με την κατεύθυνση της ροής του ποταμού. 

Στο Σχήμα 3.9 παρουσιάζεται η πορεία υπολογισμού των βασικών χαρακτηριστικών της 

γραμμής ροής από το HEC-GeoRAS: “RAS Geometry → Stream Centerline Attributes → 

Topology, Lengths/Stations, Elevations, All”. Οι επιλογές “Topology” και “Lengths/Stations” 

υπολογίζουν τη σύνδεση και τον προσανατολισμό των τμημάτων του υδρογραφικού δικτύου και 

το μήκος/φορά της ροής της κύριας γραμμής, αντίστοιχα. Η εντολή Elevations, υπολογίζει την 

τρισδιάστατη μορφή του ποταμού χρησιμοποιώντας τα δεδομένα του ψηφιακού μοντέλου 

εδάφους. Η δημιουργία αυτής της τρισδιάστατης μορφής είναι προαιρετική καθώς τα 

αποτελέσματά της δεν εξάγονται στο γεωμετρικό αρχείο.   
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Σχήμα 3.9: Πορεία υπολογισμού των χαρακτηριστικών της κύριας γραμμής 

Τέλος, απαιτείται και η ονομασία της κύριας γραμμής μέσω του παραθύρου διαλόγου “Assign 

River Code and Reach Code to River” το οποίο εμφανίζεται πατώντας στο εικονίδιο  (βλ. 

Σχήμα 3.10). 

 

Σχήμα 3.10: Ονομασία κύριας γραμμής  

Η τελική εικόνα του ψηφιοποιημένου ποταμού παρουσιάζεται στο Σχήμα 3.11. 
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.  

Σχήμα 3.11: Απεικόνιση κύριας γραμμής ποταμού σε περιβάλλον GIS 

Αφού ολοκληρωθεί η ψηφιοποίηση του ποταμού, μπορούμε να ελέγξουμε τα χαρακτηριστικά 

μέσω του “Attribute Table”, πατώντας πάνω στο “River Layer”. Στο Σχήμα 3.12 βλέπουμε, 

μεταξύ άλλων, το μήκος του ψηφιοποιημένου τμήματος και το όνομα του ποταμού. 

 

Σχήμα 3.12: Απεικόνιση του Attribute Table της κύριας γραμμής 

(β) Όχθες (Bank Stations) 

Η δημιουργία του συγκεκριμένου θεματικού επιπέδου είναι προαιρετική, ωστόσο, αν δεν 

πραγματοποιηθεί μέσω του HEC-GeoRAS, θα πρέπει να καθοριστεί αργότερα στο HEC-RAS. Οι 

όχθες χρησιμοποιούνται για να ξεχωρίσουν την ροή μέσα στο ποτάμι από την ροή στις γειτονικές 

περιοχές οι οποίες πλημμυρίζουν. Αποτελούν τεθλασμένες γραμμές που θα πρέπει να τέμνονται 

από τις διατομές, μπορούν να είναι συνεχείς ή διακεκομμένες και δεν επιβάλλεται να 
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δημιουργούνται σύμφωνα με την κατεύθυνση της ροής του ποταμού. Η σειρά των εντολών για 

την δημιουργία τους είναι η εξής: “RAS Geometry → Create RAS → Layers Bank Lines”. 

Στην παρούσα εργασία οι όχθες δημιουργήθηκαν στο HEC-RAS. 

(γ) Κύρια διεύθυνση ροής (Flow Path Centerlines) 

Η κύρια διεύθυνση ροής προσδιορίζει την κατάντη απόσταση μεταξύ των διατομών και των 

όχθεων. Ψηφιοποιείται από το μενού του HEC-GeoRAS, “RAS Geometry → Create RAS Layers 

→ Flow Path Centerlines”. Η επισήμανση της διεύθυνσης ροής πραγματοποιείται με το εργαλείο  

 (“Select Flow path and Assign Line Type Attributes”). 

(δ) Διατομές (XS Cut Lines) 

Επιλέγοντας “RAS Geometry → Create RAS Layers → XS Cut Lines” ψηφιοποιούμε τις 

διατομές του ποταμού. Με το εργαλείο  (“Construct XS Cut Lines”), ορίζουμε την απόσταση 

μεταξύ των διατομών και το μήκος τους (βλ. Σχήμα 3.13). 

 

Σχήμα 3.13: Ορισμός απόστασης και μήκους διατομών 

Ακολουθεί ο προσδιορισμός των βασικών χαρακτηριστικών των διατομών μέσω της πορείας 

“RAS Geometry → XS Cut Line Attributes → River/Reach Names, Stationing, Bank Stations, 

Downstream Reach Lengths, Elevations”. Η εντολή “River/Reach Names” προσθέτει το όνομα 

του ποταμού σε κάθε διατομή, με βάση την διασταύρωση στοιχείων με την κεντρική γραμμή 

ροής. Οι εντολές “Stationing”, “Bank Stations” και “Downstream Reach Lengths”, υπολογίζουν 

την απόσταση της κάθε διατομής από το πέρας του ποταμού, από τις εκατέρωθεν όχθες και από 

την αμέσως επόμενη κατάντη διατομή, αντίστοιχα. Τέλος, η εντολή Elevations υπολογίζει τα 
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υψόμετρα κάθε διατομής, με βάση τα δεδομένα του ψηφιακού μοντέλου εδάφους και δημιουργεί 

τρισδιάστατες διατομές (βλ. Σχήμα 3.14). 

 

Σχήμα 3.14: Πορεία υπολογισμού των χαρακτηριστικών των διατομών 

Στην παρούσα εργασία, κρίθηκε σκόπιμο να γίνει μια πύκνωση των διατομών, ανά 10 m, στο 

σημείο του φράγματος Πουρνάρι ΙΙ καθώς η απότομη μείωση του υψομέτρου στην θέση του 

φράγματος δημιουργούσε ένα κενό στο πλημμυρικό πεδίο στην συγκεκριμένη θέση. Επίσης, σε 

δύο σημεία του ψηφιακού μοντέλου εδάφους στα οποία δεν έχουμε στοιχεία και τα οποία είναι 

πάνω στην γραμμή ροής του Αράχθου, δημιουργήθηκαν διατομές αμέσως ανάντη και κατάντη 

αυτών, για την όσο δυνατόν καλύτερη εξαγωγή αποτελεσμάτων. 

Η εικόνα η οποία προκύπτει ύστερα από την ψηφιοποίηση του ποταμού και των διατομών 

παρουσιάζεται στο Σχήμα 3.15. 
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Σχήμα 3.15: Απεικόνιση διατομών σε περιβάλλον CIS 

Με την χρήση του εργαλείου  (“Plot Cross Section”) μπορούμε να επιλέξουμε και να 

παρακολουθήσουμε τα υψόμετρα οποιασδήποτε διατομής. Στο Σχήμα 3.16 παρουσιάζεται η 

απεικόνιση μιας τυχαίας διατομής όπως προκύπτει σε περιβάλλον GIS.   
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Σχήμα 3.16: Απεικόνιση διατομής 

Όλα τα χαρακτηριστικά των διατομών εμφανίζονται στον πίνακα “Attribute Table” του 

αντίστοιχου Layer (βλ. Σχήμα 3.17). 

 

Σχήμα 3.17: Απεικόνιση του Attribute Table των διατομών 

Οι διατομές μπορούν να δημιουργηθούν και χειροκίνητα, από την εργαλειοθήκη “3D Analyst → 

Interpolate Line”, αρκεί να πληρούν κάποιες προϋποθέσεις. Θα πρέπει να είναι κάθετες στην 
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γραμμή του ποταμού, να σχεδιάζονται από αριστερά προς τα δεξιά κοιτώντας κατάντη τον 

ποταμό και να καλύπτουν ολόκληρη την περιοχή κατάκλυσης. 

(ε) Χρήσεις γης (Landuse Areas) 

Το θεματικό επίπεδο των χρήσεων γης, είναι απαραίτητο για τον προσδιορισμό των συντελεστών 

Manning και η δημιουργία του πραγματοποιείται μέσω του HEC GeoRAS ακολουθώντας τις 

εντολές “RAS Geometry → Create RAS Layers → Landuse Areas”. Εισάγεται ο χάρτης 

χρήσεων γης CORINE 2000 και απομονώνονται μόνο οι χρήσεις γης οι οποίες τέμνονται από τις 

διατομές. Η σειρά εντολών “RAS Geometry → Manning’s n Values → Create LU Manning 

Table” και στην συνέχεια “Extract N Values”, παράγει και εξάγει πίνακα ο οποίος περιέχει τις 

αντιστοιχίες κάθε πολυγώνου με τον συντελεστή Manning. 

Ο συντελεστής Manning εκφράζει τις αντιστάσεις τριβών, οι οποίες οφείλονται στην τραχύτητα 

της βρεχόμενης περιμέτρου. Είναι λοιπόν αναγκαίο, να υπολογισθούν οι συντελεστές Manning, 

όχι μόνο της περιμέτρου του ποταμού αλλά και της περιμέτρου των γειτονικών περιοχών οι 

οποίες πλημμυρίζουν. 

Η αντιστοιχία των συντελεστών Manning σε κάθε χρήση γης παρουσιάζεται στον πίνακα που 

ακολουθεί (Πίνακας 3-1; Yan Huang, 2005). 

Πίνακας 3-1: Συντελεστής Manning (Πηγή: Yan Huang, 2005) 

LU 
Code 

Νmax N min N norm Description 

243 0.0582 0.0419 0.0500 Αγροτικές εκτάσεις με σημαντικό ποσοστό φυσικής 
βλάστησης 

323 0.1000 0.0700 0.0850 Σκληρόφυλλη βλάστηση 
223 0.2000 0.1000 0.1500 Ελαιώνας 
222 0.4071 0.0293 0.0350 Οπωρώνες και καλλιέργειες 
242 0.0582 0.0419 0.0500 Συμπλέγματα καλλιεργειών 
331 0.0523 0.0377 0.0450 Παραλίες, αμμοθίνες και αμμώδεις εκτάσεις 
112 0.0174 0.0126 0.0150 Ασυνεχής αστικός ιστός 
121 0.2326 0.1674 0.2000 Βιομηχανικές ή εμπορικές μονάδες 
511 0.0330 0.0270 0.0300 Υδάτινο ρεύμα 
321 0.0350 0.0300 0.0330 Θάμνοι  και χορτολίβαδα 
312 0.2500 0.1500 0.2000 Κωνοφόρα δάση 
133 0.1396 0.1004 0.1200 Εργοτάξια 
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Στην παρούσα εργασία, οι συντελεστές Manning εισήχθησαν αργότερα στο HEC-RAS. 

3.2.4 Σύνθεση θεματικών επιπέδων 

Αφού δημιουργηθούν τα απαραίτητα θεματικά επίπεδα, πρέπει να πραγματοποιηθεί η σύνθεσή 

τους, “RAS Geometry → Layer Setup”, για να είναι εφικτή η εξαγωγή τους από το ArcGIS και 

αργότερα η εισαγωγή τους στο HEC-RAS (βλ. Σχήμα 3.18). 

 

Σχήμα 3.18: Σύνθεση θεματικών επιπέδων 

Το παράθυρο διαλόγου το οποίο εμφανίζεται έχει τέσσερις καρτέλες προσδιορισμού δεδομένων. 

Στις καρτέλες αυτές θα πρέπει να καθοριστούν υποχρεωτικά, το ψηφιακό μοντέλο έδαφος, η 

κύρια γραμμή ροής και οι διατομές. 

3.2.5 Εξαγωγή γεωμετρικού αρχείου 

Η εξαγωγή του γεωμετρικού αρχείου πραγματοποιείται με τις ακόλουθες εντολές: “RAS 

Geometry → Export RAS Data” οι οποίες φαίνονται στο Σχήμα 3.19. Το αρχείο το οποίο 

δημιουργείται είναι μορφής XML. 
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Σχήμα 3.19: Εξαγωγή γεωμετρικού αρχείου 

3.3 Υδραυλική προσομοίωση Αράχθου 

3.3.1 Μοντέλο υδραυλικής προσομοίωσης HEC-RAS 

Το πακέτο HEC-RAS, αναπτύχθηκε από το U.S. Army Corps of Engineers (Αμερικανικό 

Στρατιωτικό Σώμα Μηχανικών), για την εκτέλεση υδραυλικών υπολογισμών σε μονοδιάστατες 

μόνιμες ή μη μόνιμες ροές ποταμών. Μια πρώιμη εκδοχή του HEC-RAS είναι το πακέτο HEC-2 

το οποίο περιοριζόταν στην ανάλυση μονοδιάστατης μόνιμης ροής. Η πρώτη έκδοση του HEC-

RAS (version 1.0) κυκλοφόρησε το 1995 και βασικοί δημιουργοί του ήταν οι Mr. Mark και R. 

Jensen. 

Ειδικότερα, το HEC-RAS είναι μια ολοκληρωμένη σουίτα λογισμικών σχεδιασμένη για 

διαδραστική χρήση καθώς και για χρήση σε επίπεδο δικτύου υπολογιστών. Τα βασικά μέρη της 

πλατφόρμας είναι: το γραφικό περιβάλλον επικοινωνίας (GUI) με τον χρήστη, ο πυρήνας 

υδραυλικών αναλύσεων καθώς και δυνατότητες αποθήκευσης, διαχείρισης και επεξεργασίας 

δεδομένων εισόδου και εξόδου.  
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Τα κύρια είδη μονοδιάστατων αναλύσεων τα οποία παρέχονται από την πλατφόρμα είναι τα 

εξής: (1) μόνιμη ροή επιφανειακών υδάτων, (2) μη μόνιμη ροή επιφανειακών υδάτων, (3) 

προσομοίωση μεταφοράς φερτών με μεταβαλλόμενα όρια, και (4) ανάλυση ποιότητας νερού. 

Πέραν αυτών η πλατφόρμα περιέχει επιπλέον λειτουργίες που ενεργοποιούνται μετά την επίλυση 

και υπολογισμό του προφίλ επιφανειακών υδάτων. Ακολουθεί σύντομη ανάλυση της κάθε μιας 

από τις παραπάνω βασικές αναλύσεις: 

Μόνιμη ροή επιφανειακών υδάτων: Το παρόν εργαλείο επιτρέπει τον υπολογισμό του προφίλ 

επιφανειακών υδάτων για μόνιμη σταδιακά μεταβαλλόμενη ροή. Πέραν της επίλυσης ενός και 

μόνο ποταμιού, το σύστημα υποστηρίζει επίσης ποτάμι με διακλαδώσεις καθώς ένα πλήρες 

δίκτυο ποταμιών και καναλιών. Σε μόνιμες συνθήκες ροής, τόσο η υπερκρίσιμη, υποκρίσιμη ή 

και μικτού τύπου ροή υποστηρίζονται.  

Η υπολογιστική διαδικασία βασίζεται στην επίλυση της μονοδιάστατης εξίσωσης διατήρησης της 

ενέργειας. Οι απώλειες ενέργειας οφείλονται αφενός στη τριβή (συντελεστής Manning) όσο και 

στις διεργασίες συμπύκνωσης/επέκτασης (συντελεστής πολλαπλασιασμένος με την αλλαγή 

ταχύτητας). Η εξίσωση διατήρησης της ορμής χρησιμοποιείται μόνο σε περιπτώσεις ταχείας 

μεταβαλλόμενης ροής, όπως είναι οι μικτού τύπου ροές (π.χ. υδραυλικά άλματα), υδραυλικοί 

υπολογισμοί σε γέφυρες και οι υπολογισμοί σε συμβολές ποταμών. Επίσης, η επίδραση 

διαφόρων εμποδίων όπως είναι οι γέφυρες, υπερχειλιστές, οχετοί και ιχθυοφραγμοί, μπορεί να 

ενσωματωθεί στην πλατφόρμα και άρα στην επίλυση. Η λειτουργία του HEC-RAS με μόνιμη 

ροή έχει σχεδιαστεί για εφαρμογές όπως η διαχείριση της πλημμύρας, του πλημμυρικού πεδίου 

και η κατάρτιση πλημμυρικών χαρτών για την εκτίμηση του ρίσκου από πλημμυρικά φαινόμενα. 

Φυσικά, η συγκεκριμένη λειτουργία μπορεί να χρησιμοποιηθεί και στην προσομοίωση της 

αλλαγής της ροής των ποταμών λόγω βελτιώσεων στα κανάλια ή στα αναχώματα.       

Μεταφορά φερτών /Υπολογισμοί μεταβαλλόμενων ορίων: Το παρόν εργαλείο επιτρέπει την 

προσομοίωση της μονοδιάστατης μεταφοράς φερτών και μεταβαλλόμενων ορίων που 

προκύπτουν από την απόθεση καθώς και τον καθαρισμό φερτών σε μεσαίες χρονικές κλίμακες 

(π.χ. έτος). Το μοντέλο που χρησιμοποιείται έχει σχεδιαστεί για την προσομοίωση και πρόβλεψη 

μακροπρόθεσμων τάσεων μεταφοράς φερτών σε υδάτινα σώματα που οφείλονται είτε στη 

μεταβολή της συχνότητας και διάρκειας της απορροής είτε στη γεωμετρία του καναλιού λόγω 

εξωτερικών παρεμβάσεων.  
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Μη μόνιμη ροή επιφανειακών υδάτων: Το παρόν εργαλείο επιτρέπει τον υπολογισμό της 

μόνιμης ροής υδάτων μέσω ενός πλήρους δικτύου ανοιχτών καναλιών. Το σύστημα εξισώσεων 

μη μόνιμης ροής που ενσωματώνει το HEC-RAS είναι αυτό του μοντέλου UNET, του Dr. Robert 

L. Barkau’s (Barkau, 1992). Το σύστημα αυτό αναπτύχθηκε και προορίζεται κυρίως για τον 

υπολογισμό υποκρίσιμων ροών. Η δυνατότητα προσθήκης στοιχείων όπως διατομές, γέφυρες, 

οχετοί και λοιπές υδραυλικές κατασκευές υπάρχει και στην περίπτωση μη μόνιμης ροής.    

Ανάλυση ποιότητας υδάτων: Το παρόν εργαλείο επιτρέπει τον υπολογισμό και ανάλυση των 

ποιοτικών χαρακτηριστικών του ποταμού. Η παρούσα έκδοση του HEC-RAS (version 4.0) 

επιτρέπει λεπτομερή ανάλυση της θερμοκρασίας καθώς και την ανάλυση συγκέντρωσης άλγεων, 

διαλυμένου οξυγόνου, οργανικών συστατικών, νιτρικών και άλλων στοιχείων.              

Στην παρούσα εργασία, η υδραυλική προσομοίωση του Αράχθου πραγματοποιήθηκε σε 

συνθήκες μόνιμης ροής. 

3.3.2 Εισαγωγή γεωμετρικού αρχείου στο HEC-RAS 

Αρχικά, θα πρέπει να δημιουργηθεί και να ονοματιστεί ένα νέο αρχείο, μέσω των εντολών “File 

→ New Project”. Η εισαγωγή του γεωμετρικού αρχείου στο HEC-RAS απαιτεί την ακόλουθη 

σειρά εντολών: “Edit → Geometric Data → File → Import Geometry Data → GIS Format” (βλ. 

Σχήμα 3.20). 

 

Σχήμα 3.20: Πορεία εισαγωγής γεωμετρικού αρχείου 



 

42 
 

3.3.3 Επεξεργασία γεωμετρικού αρχείου 

Με την εισαγωγή του γεωμετρικού αρχείου έχουμε μια πρώτη εικόνα (Σχήμα 3.21) του ποταμού 

και των διατομών του. 

 

Σχήμα 3.21: Εικόνα γεωμετρικού αρχείου σε περιβάλλον HEC-RAS 

Όπως φαίνεται και στο Σχήμα 3.21, οι διατομές ορίζονται και ονομάζονται, ανάλογα με την 

απόστασή τους από το κατάντη σημείο πέρατος του ποταμού. Η ονομασία κάθε διατομής μπορεί 

να καθοριστεί και από τον χρήστη μέσω των εντολών “Cross Section Data → Options → 

Rename River Station”. Επίσης, εμφανίζεται με ένα βέλος η φορά της ροής του ποταμού, όπως 

αυτή ορίστηκε κατά την ψηφιοποίηση της κύριας γραμμής ροής. 

Με την εντολή “Cross Section” έχουμε πρόσβαση σε όλα τα δεδομένα της κάθε διατομής. Η 

εμφανιζόμενη καρτέλα μας πληροφορεί για την αντιστοιχία απόστασης-υψομέτρου (“Cross 

section Coordinates”) για όλα τα σημεία τα οποία απαρτίζουν την εν λόγω διατομή, για την 

απόσταση της διατομής από την αμέσως κατάντη (“Downstream Reach Lengths”) καθώς και για 

τις τιμές του συντελεστή Manning (“Manning’s n Values”). Μπορούμε επίσης, να δούμε τους 
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συντελεστές συστολής και διαστολής (“Cont/Exp Coefficient”), τις συντεταγμένες των όχθεων 

(“Main Channel Bank Stations”), ενώ με το εργαλείο “Jump to the Graphical Cross Section 

Editor” ( ) μπορούμε να μορφοποιήσουμε τις συντεταγμένες των όχθεων (βλ. Σχήμα 3.22). 

 

Σχήμα 3.22: Καρτέλα γεωμετρικών χαρακτηριστικών διατομής 

3.3.4 Εισαγωγή υδρολογικών δεδομένων 

Λόγω της ύπαρξης του υδροηλεκτρικού φράγματος του Πουρναρίου και του συγκροτήματος 

εκχειλιστή, τα οποία υπάρχουν στην υπό μελέτη περιοχή, δεν πραγματοποιήθηκε υδρολογική 

προσομοίωση της λεκάνης απορροής του ποταμού. Η υδραυλική προσομοίωση 

πραγματοποιήθηκε, για τρια διαφορετικά σενάρια διαχείρισης του εκχειλιστή, για το επεισόδιο 

πλημμύρας στις 28-31/12/2005. Περισσότερες λεπτομέρειες για το πώς προέκυψαν τα υπό 

μελέτη σενάρια δίνονται στο Κεφάλαιο 6. Τα σενάρια αυτά είναι τα ακόλουθα:  

(α) Q1 = 1700 m3/s. Εφόσον το άνοιγμα του εκχειλιστή γινόταν σύμφωνα με τους κανόνες 

λειτουργίας του, όταν δηλαδή η στάθμη του ταμιευτήρα φτάσει τα 120 m, θα έπρεπε η 

παροχή εκροής (από τον εκχειλιστή 1200 m3/s και από τους στροβίλους του 

υδροηλεκτρικού φράγματος 500 m3/s) να είναι ίση με την παροχή εισροής, ώστε να 

διατηρείται σταθερή η στάθμη στα 120 m.   
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(β) Q2 = 800 m3/s. Το άνοιγμα των θυροφραγμάτων του εκχειλιστή έγινε όταν η στάθμη 

έφτανε τα 118 m. Διοχετεύτηκαν 500 m3/s από το υδροηλεκτρικό φράγμα και 300 m3/s από 

τον εκχειλιστή. 

(γ) Q3 = 640 m3/s. Παροχή εκροής μικρότερη, από την παροχή η οποία διοχετεύτηκε στον 

ποταμό. 

Οι παροχές αυτές εισάγονται στο HEC-RAS μέσω των εντολών: “Edit → Steady Flow Data” 

(Σχήμα 3.23). 

 

Σχήμα 3.23: Εισαγωγή πλημμυρικών αιχμών 

Στην καρτέλα η οποία εμφανίζεται, θα πρέπει να καθοριστούν ο αριθμός των σεναρίων του 

πλημμυρικού επεισοδίου και το όνομά τους (μέσω των εντολών “Options → Edit Profile 

Names”) καθώς επίσης και οι οριακές συνθήκες (“Reach Boundary Conditions”). Οι οριακές 

συνθήκες είναι απαραίτητες για να καθοριστεί το αρχικό πιεζομετρικό φορτίο του ποταμού, 

προκειμένου να ξεκινήσουν οι υδραυλικοί υπολογισμοί, στα άκρα του ποταμού. Στην 

υποκρίσιμη ροή, είναι απαραίτητο να καθοριστεί η οριακή συνθήκη στην πλέον κατάντη θέση 

του ποταμού. Αντίθετα, στην υπερκρίσιμη ροή απαιτείται ο προσδιορισμός της οριακής 

συνθήκης στην πλέον ανάντη θέση του ποταμού. Τέλος, στην περίπτωση μικτής ροής είναι 

απαραίτητος ο προσδιορισμός των οριακών συνθηκών τόσο ανάντη όσο και κατάντη. Η καρτέλα 

επεξεργασίας και καθορισμού των οριακών συνθηκών μας παρέχει μια πληθώρα επιλογών για ον 

καθορισμό των οριακών συνθηκών: 
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(α) Known Water Surface Elevations (Γνωστό πιεζομετρικό φορτίο)  

Στην συγκεκριμένη οριακή συνθήκη θα πρέπει να εισαχθεί το πιεζομετρικό φορτίο για κάθε 

σενάριο το οποίο θέλουμε να υπολογιστεί. 

(β) Critical Depth (Κρίσιμο βάθος) 

Σε αυτή την περίπτωση δεν επιβάλλεται στον χρήστη να προσθέσει κάποια πληροφορία. Το 

πρόγραμμα υπολογίζει το κρίσιμο βάθος το οποίο θα αποτελέσει την οριακή συνθήκη. 

(γ) Normal Depth (Ομοιόμορφο βάθος) 

Σε αυτή την οριακή συνθήκη είναι απαραίτητο να εισάγει ο χρήστης το ομοιόμορφο βάθος για 

κάθε σενάριο. 

(δ) Rating Curve (Καμπύλη στάθμης – παροχής) 

Με την επιλογή της συγκεκριμένης συνοριακής συνθήκης εισάγουμε ζεύγη στάθμης παροχής και 

το πρόγραμμα υπολογίζει, με παρεμβολή, το πιεζομετρικό φορτίο για κάθε σενάριο. 

Στην παρούσα εργασία επιλέχθηκε μικτή ροή και για τον καθορισμό των οριακών συνθηκών 

επιλέχθηκε η εισαγωγή του ομοιόμορφου βάθους όπως αυτό προέκυψε από τις κλίσεις, σε 

περιβάλλον HEC-RAS (“Spatial Analyst → Slope”). Έτσι ορίστηκε η κλίση τόσο ανάντη 

(0.169), όσο και κατάντη (0.029) του ποταμού (βλ. Σχήμα 3.24).  
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Σχήμα 3.24: Καθορισμός οριακών συνθηκών 

3.3.5 Εκτέλεση υδραυλικών υπολογισμών 

Το τελευταίο στάδιο της υδραυλικής προσομοίωσης είναι η εκτέλεση των υδραυλικών 

υπολογισμών από το κεντρικό παράθυρο του προγράμματος, το οποίο παρουσιάζεται στο Σχήμα 

3.25 με την χρήση των ακόλουθων εντολών: “Run → Steady Flow Analysis”. Η εμφανιζόμενη 

καρτέλα μας επιτρέπει να καθορίσουμε το όνομα σχεδίου (“Short ID”), την προέλευση του 

γεωμετρικού αρχείου (“Geometry File”), των υδρολογικών δεδομένων μόνιμης ροής (“Steady 

Flow File”) και του είδους της ροής (“Flow Regime”) 

 

Σχήμα 3.25: Καρτέλα εκτέλεσης υδραυλικών υπολογισμών 
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Κεφάλαιο 4ο  

4 Υδραυλική προσομοίωση μέσω LISFLOOD-FP 

4.1 Μοντέλο υδραυλικής προσομοίωσης LISFLOOD-FP 

Το μοντέλο LISFLOOD-FP είναι προϊόν ερευνητικής δουλειάς του Πανεπιστημίου του Bristol 

και του EU Joint Research Center με σκοπό την απλοποιητική, αλλά φυσικά εύλογη, 

προσομοίωση της δυναμικής που παρουσιάζουν τα πλημμυρικά γεγονότα σε πεδία με υψηλή 

χωρική διακριτότητα (http://www.bristol.ac.uk/geography/research/hydrology/models/lisflood/). 

Το μοντέλο σχεδιάστηκε έτσι ώστε να λειτουργεί πάνω σε ένα τυπικό Καρτεσιανό πεδίο, με 

σκοπό την εύκολη σύνδεση με τα διαθέσιμα δεδομένα GIS, ενώ αναπτύχθηκε στο δυναμικό 

προγραμματιστικό περιβάλλον PCRASTER. Το μοντέλο προσομοιώνει/προβλέπει το βάθος 

νερού σε κάθε κελί του κάναβου σε κάθε χρονικό βήμα, και επομένως είναι ικανό να αποδώσει 

τη δυναμική διάδοση του πλημμυρικού κύματος σε ποτάμια και παράκτια πεδία καθώς και σε 

εκβολές ποταμών.     

Το LISFLOOD-FP αποτελεί ένα συνδυασμένο 1-διάστατο/2-διάστατο υδραυλικό μοντέλο που 

ενσωματώνει μια τακτική πλήρωσης όγκου νερού σε κάθε κελί, βασισμένη στις θεμελιώδεις 

αρχές υδραυλικής και στην αρχή διατήρησης της μάζας και συνέχειας. Το μοντέλο 

χαρακτηρίζεται ως ψεύδο-διδιάστατο, καθώς δεν κάνει πραγματική ανάλυση της ροής σε δυο 

διαστάσεις, αλλά χρησιμοποιεί μονοδιάστατη ανάλυση αφενός για την κύρια διεύθυνση ροής και 

αφετέρου για την εγκάρσια διεύθυνση, όπως παρουσιάζεται στο Σχήμα 4.1. Οι δυο αναλύσεις 

εκτελούνται ανεξάρτητα και συνδυάζονται μέσω μιας σχέσης συνέχειας.    

Ως ελάχιστα δεδομένα εισόδου το μοντέλο δέχεται το πλάτος του καναλιού και την κλίση του 

πυθμένα του, τα τοπογραφικά υψόμετρα και τους συντελεστές τραχύτητας Manning τόσο του 

καναλιού όσο και του πλημμυρικού πεδίου, καθώς και τις οριακές συνθήκες.     

Οι βασικές παραδοχές που υιοθετεί το μοντέλο για την ανάλυση που ακολουθεί είναι: 

(α) Η βασική ροή στο κανάλι μπορεί να προσομοιωθεί είτε μέσω της κινηματικού κύματος είτε 

μέσω κύματος διάχυσης. 
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(β) Το ποτάμι είναι ρηχό και φαρδύ έτσι ώστε η βρεχόμενη περίμετρος προσεγγίζεται 

ικανοποιητικά από το πλάτος του ποταμιού. Αυτό έχει σαν αποτέλεσμα οι πλευρικές τριβές 

να θεωρούνται αμελητέες.  

(γ) Για τη μετάδοση της πλημμύρας τόσο εντός του καναλιού όσο και εγκάρσια (εκτός των 

ορίων της κοίτης) χρησιμοποιούνται κελιά αποθήκευσης διακριτοποιημένα πάνω στο πλέγμα 

του μοντέλου εδάφους.   

(δ) Η ροή μεταξύ των κελιών αποθήκευσης υπολογίζεται μέσω αναλυτικών σχέσεων 

ομοιόμορφης ροής (Εξίσωση Manning ή Εξίσωση εκχειλιστή). Με αυτό τον τρόπο 

προσεγγίζεται ικανοποιητικά η διάχυση του κύματος σε δυο διαστάσεις.  

(ε) Δεν υπάρχει μεταφορά ορμής μεταξύ του κύριου καναλιού και των εγκάρσιων πεδίων, μόνο 

μεταφορά μάζας. 

(στ)  Θεωρούμαι ομαλά μεταβαλλόμενη ροή. 

(ζ) Το μοντέλο χρησιμοποιεί μονάδες μέτρησης από το σύστημα SI, δηλαδή μέτρα για το μήκος, 

δευτερόλεπτα για το χρόνο, κυβικά ανά δευτερόλεπτα για την παροχή κτλ.    

 

Σχήμα 4.1: Το μοντέλο LISFLOOD-FP (Πηγή: http://www.bristol.ac.uk/geography/ 
research/hydrology/models/lisflood/structure/)  

Η διάδοση του πλημμυρικού κύματος κατά την κύρια διεύθυνση ροής γίνεται μέσω των 

μονοδιάστατων εξισώσεων συνέχειας (Εξ. (4.1)) και διατήρησης της ορμής (Εξ. (4.2)). Οι 

εξισώσεις που χρησιμοποιεί το μοντέλο είναι οι ακόλουθες: 

 
dQ dA

q
dx dt

    (4.1) 
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2 4 2

0 10/3
0

n P Q dh
S

A dx

      
  (4.2) 

όπου Q η παροχή στο κανάλι, Α η βρεχόμενη επιφάνεια της διατομής, q η εισροή προς το κύριο 

κανάλι από άλλες πηγές, S0 η κλίση του πυθμένα του καναλιού, n ο συντελεστής τραχύτητας 

Manning, P η βρεχόμενη περίμετρος της διατομής και h το βάθος της ροής. 

Ο τελευταίος όρος της Εξίσωσης (4.2) εκφράζει τη μεταφορά λόγω διάχυσης του κύματος που 

ωθεί το ποτάμι να ανταποκρίνεται τόσο στη κλίση του πυθμένα όσο και στην κλίση της 

ελεύθερης επιφάνειας. Ο χρήστης μπορεί να επιλέξει μεταξύ της χρήσης κινηματικού κύματος ή 

κύματος λόγω διάχυσης κατά την προσομοίωση.  

Η επίλυση των παραπάνω εξισώσεων δεν μπορεί να γίνει αναλυτικά και για αυτό το λόγο 

υιοθετείται ένα σχήμα διακριτοποίηση πεπερασμένων διαφορών και ρητό σχήμα επίλυσης για να 

εκφράσει τη χρονική εξάρτηση μεταξύ διαδοχικών χρονικών βημάτων. Τελικά διαμορφώνεται 

ένα μη γραμμικό σύστημα εξισώσεων που επιλύεται με την επαναληπτική μέθοδο Newton-

Raphson.    

Όταν γίνει πλήρωση του ποταμού, το νερό μεταφέρεται στο υπερκείμενο πλημμυρικό πεδίο 

(πλευρική – εγκάρσια ροή). Η πλευρική ροή περιγράφεται από τις εξισώσεις συνέχειας και 

διατήρησης της ορμής, πάνω σε ένα διακριτοποιημένο κάναβο τετραγωνικών φατνίων το οποίο 

επιτρέπει την αναπαράσταση της διδιάστατης ροής. Όπως φαίνεται και στο Σχήμα 4.2 που 

ακολουθεί, υποθέτουμε ότι η ροή είναι συνάρτηση της διαφοράς των υψών ελεύθερης επιφάνειας 

μεταξύ γειτονικών κελιών. Οι μαθηματικές εξισώσεις που χρησιμοποιούνται για την εν λόγω 

περιγραφή, μεταξύ δυο φατνίων i και j, είναι οι ακόλουθες: 

 
1, , , 1 ,, i j i j i j i ji j

x x y yQ Q Q Qdh

dt x y

   


 
  (4.3) 

 

1/25/3 1, ,
,

i j i j
flowi j

x

h h h
Q y

n x

 
   

  (4.4) 

 

1/25/3 1, ,
,

i j i j
flowi j

y

h h h
Q x

n y

 
   

  (4.5) 
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όπου hi,j το ύψος της ελεύθερης επιφάνειας στο φατνίο (i, j), Δx και Δy οι διαστάσεις του 

φατνίου, n ο συντελεστής τραχύτητας Manning για το πλημμυρικό πεδίο, Qx και Qy οι παροχές 

μεταξύ των φατνίων στις δυο διευθύνσεις x και y, hflow το βάθος ώστε να υπάρχει ροής από το 

ένα φατνίο στο άλλο που ορίζεται ως η διαφορά μεταξύ της υψηλότερης ελεύθερης επιφάνειας 

των δυο φατνίων και του υψηλότερου υψομέτρου από το επίπεδο αναφοράς των δυο φατνίων.   

 

Σχήμα 4.2: Ροή μεταξύ γειτονικών κελιών (Πηγή: http://www.bristol.ac.uk/geography/ 
research/hydrology/models/lisflood/structure/) 

Το μοντέλο επιτρέπει στο χρήστη να ορίσει το χρονικό βήμα προσομοίωσης. Ωστόσο, η επιλογή 

αυτή θα πρέπει να ισορροπεί δυο, γενικά, αντικρουόμενα κριτήρια. Αφενός θα πρέπει να 

εξασφαλίζεται η μέγιστη υπολογιστική αποδοτικότητα και αφετέρου, η σταθερότητα των 

υπολογισμών. Το εργαλείο ενσωματώνει την επιλογή προσαρμοζόμενου/βέλτιστου χρονικού 

βήματος που προκύπτει από την ανάλυση των παραπάνω εξισώσεων και ενός ανάλογου 

συστήματος διάχυσης. 

4.2 Δημιουργία αρχείων εισόδου  

Δεδομένα εισόδου του προγράμματος αποτελούν τα γεωμετρικά χαρακτηριστικά της περιοχής 

μελέτης (καναλιού και πλημμυρικού πεδίου), τα υδρολογικά δεδομένα και φυσικά οι οριακές 

συνθήκες. 
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Τα γεωμετρικά χαρακτηριστικά του πλημμυρικού πεδίου περιλαμβάνονται σε ένα αρχείο μορφής 

ascii με επέκταση αρχείου .dem.ascii όπως φαίνεται στο Σχήμα 4.3. Το αρχείο αυτό το εξάγουμε 

από το περιβάλλον του GIS με τις εξής εντολές: “Arc Toolbox → Conversion Tools → From 

Raster → Raster to ASCII”. Στο παράθυρο διαλόγου το οποίο εμφανίζεται εισάγουμε το 

Ψηφιακό Μοντέλο Εδάφους και ορίζουμε τον φάκελο αποθήκευσης του παραχθέντος αρχείου. 

 

Σχήμα 4.3: Απεικόνιση αρχείου με τα γεωμετρικά χαρακτηριστικά του πλημμυρικού πεδίου 

Ένα αρχείο μορφής ascii, με επέκταση αρχείου .n.ascii, περιλαμβάνει τις τιμές του συντελεστή 

τραχύτητας Manning και εξάγεται επίσης από το GIS (βλ. Σχήμα 4.4). Αρχικά μετατρέπουμε το 

πολύγωνο των χρήσεων γης σε αρχείο τύπου raster πραγματοποιώντας την ακόλουθη σειρά 

εντολών: “Arc Toolbox → Conversion Tools → To Raster → Polygon to Raster”. Έπειτα 

ακολουθώντας τις εντολές οι οποίες προαναφέρθηκαν, για την εξαγωγή του αρχείου με τα 

γεωμετρικά χαρακτηριστικά του πλημμυρικού πεδίου, εξάγουμε το εν λόγω αρχείο. 
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Σχήμα 4.4: Απεικόνιση αρχείου με τις τιμές του συντελεστή Manning για κάθε σημείο του πλημμυρικού 
πεδίου 

Το κανάλι θεωρείται ως ένα σύνολο διανυσμάτων κατά μήκος της κύριας γραμμής ροής του 

ποταμού. Το αρχείο το οποίο μας δίνει πληροφορίες για τα γεωμετρικά χαρακτηριστικά του 

καναλιού έχει επέκταση .river  και περιλαμβάνει τις συντεταγμένες (x, y) της κορυφής κάθε 

διανύσματος, το πλάτος του ποταμού στην συγκεκριμένη θέση, το υψόμετρο του πυθμένα και 

τον συντελεστή τραχύτητας (βλ. Σχήμα 4.5). Το πλάτος και το υψόμετρο του ποταμού 

εισήχθησαν κατ’ αντιστοιχία με αυτά τα οποία προσδιορίστηκαν στο HEC-RAS. Χρειάστηκε, 

ωστόσο, να διορθωθούν κάποια υψόμετρα ώστε αυτά να έχουν αρνητική προς τα κατάντη κλίση, 

όπως απαιτεί το μοντέλο LISFLOOD-FP για την γεωμετρία του ποταμού. Επίσης, στο ίδιο 

αρχείο εισάγονται το πλήθος των ποταμών και των διανυσμάτων για κάθε ποταμό (στην 

παρούσα εργασία έχουμε ένα ποταμό και 47 διανύσματα, όσα και οι διατομές οι οποίες 

μελετήθηκαν στο HEC-RAS) καθώς και η παροχή αιχμής όταν μελετάται μόνιμη ροή. Η 

υδραυλική προσομοίωση πραγματοποιήθηκε για τον ίδιο αριθμό σεναρίων διαχείρισης του 

εκχειλιστή, κατά την υφιστάμενη πλημμύρα στις 28-31/12/2005, όπως και στην υδραυλική 

προσομοίωση στο HEC-RAS. Οι παροχές αιχμής τέθηκαν ίσες με 640, 800 και 1700 m3/s. 
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Σχήμα 4.5: Απεικόνιση αρχείου με τα γεωμετρικά χαρακτηριστικά του ποταμού 

Οι οριακές συνθήκες εισάγονται σε ένα αρχείο μορφής .bci και περιγράφουν τις συνθήκες σε 

κάποια θέση (ανεξάρτητη από το κανάλι) του πλημμυρικού πεδίου. Οι τύποι των οριακών 

συνθηκών είναι οι εξής: 

(α) CLOSED, κλειστό όριο (Zero-flux) 

(β) FREE, ανοιχτό όριο (Uniform flow) 

(γ) HFIX, σταθερή ελεύθερη επιφάνεια νερού (Fixed Free Surface Elevation) 

(δ) HVAR, χρονικά μεταβαλλόμενη ελεύθερη επιφάνεια νερού (Time Varying Free Surface 

Elevation) 

(ε) QFIX, σταθερή παροχή (Fixed Flow Into Domain) 

(στ) QVAR, χρονικά μεταβαλλόμενη ροή (Time Varying Flow Into Domain) 

Στην παρούσα εργασία επιλέχθηκε ανοιχτό όριο (FREE) και για τα τέσσερα σημεία (ανατολή, 

δύση, βορράς, νότος) του πλημμυρικού πεδίου (βλ. Σχήμα 4.6). 
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Σχήμα 4.6: Απεικόνιση αρχείου με τις οριακές συνθήκες του πλημμυρικού πεδίου 

Τέλος δημιουργείται ένα αρχείο παραμέτρων (με επέκταση .par) το οποίο περιλαμβάνει τα 

ονόματα και τη θέση των ανωτέρω αρχείων καθώς επίσης και τις παραμέτρους οι οποίες 

ελέγχουν και ορίζουν την υδραυλική προσομοίωση και τα εξαγόμενα αποτελέσματα αυτής. Οι 

παράμετροι αυτοί είναι οι εξής: 

(α) dirroot: καθορίζουμε το όνομα του φακέλου στον οποίο θα αποθηκευτούν τα αρχεία των 

αποτελεσμάτων προσομοίωσης, 

(β) resroot: καθορίζουμε το όνομα των αρχείων τα οποία θα αποθηκευτούν στον φάκελο των 

αποτελεσμάτων και θα περιλαμβάνουν τα βάθη ροής, 

(γ) saveint: ορίζουμε το χρονικό διάστημα σε δευτερόλεπτα στο οποίο θα αποθηκεύονται τα 

αρχεία με τα βάθη ροής, 

(δ) massint: το χρονικό διάστημα σε δευτερόλεπτα στο οποίο θα αποθηκεύονται τα αρχεία 

ισοζυγίου μάζας, 

(ε) sim_time: η συνολική χρονική διάρκεια (σε δευτερόλεπτα) της προσομοίωσης,   

(στ) initial_tstep: σταθερό χρονικό βήμα σε δευτερόλεπτα.  

Στην παρούσα εργασία, η υδραυλική προσομοίωση πραγματοποιήθηκε για 20 και 50 ώρες, 

αντίστοιχα. Οι παραπάνω χρόνοι επιλέχτηκαν με δεδομένο ότι η προκαταρκτική ανάλυση έδειξε 

σταθεροποίηση της ροής κοντά στις 50 ώρες. Η εξαγωγή και αποθήκευση των αποτελεσμάτων 

γίνεται ανά μια ώρα (βλ. Σχήμα 4.7).   
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Σχήμα 4.7: Απεικόνιση αρχείου παραμέτρων 

Το αρχείο των παραμέτρων είναι το μόνο αρχείο το οποίο εισάγεται στην γραμμή εντολών του 

LISFLOOD-FP. Στο Σχήμα 4.8 φαίνεται το περιεχόμενο του φακέλου στον οποίο 

αποθηκεύονται, ανά μια ώρα, τα αρχεία με τα βάθη ροής τα οποία προέκυψαν από την 

υδραυλική προσομοίωση. 

 

Σχήμα 4.8: Απεικόνιση αρχείων αποτελεσμάτων 
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Κεφάλαιο 5ο  

5 Σύνθεση χαρτών πλημμύρας 

Σκοπός της παρούσας εργασίας είναι η κατάρτιση πλημμυρικών χαρτών οι οποίοι θα μας 

παρέχουν πληροφορίες για την πιεζομετρική επιφάνεια του ποταμού, τα όρια της κατάκλυσης 

και τα βάθη νερού. 

5.1 Πλημμυρικοί χάρτες με βάση τα αποτελέσματα του HEC-RAS 

Η σύνθεση των πλημμυρικών χαρτών, με βάση τα αποτελέσματα της υδραυλικής προσομοίωσης 

στο HEC-RAS, πραγματοποιήθηκε σε περιβάλλον ArcGIS με την ακόλουθη διαδικασία: 

(α) Εξαγωγή των αποτελεσμάτων από το HEC-RAS (βλ. Σχήμα 5.1) με τις εντολές: “File →  

Export GIS Data”. Προκύπτει ένα αρχείο μορφής SDF. 

 

Σχήμα 5.1: Διαδικασία εξαγωγής αρχείου SDF από το HEC-RAS 

(β) Εισαγωγή αποτελεσμάτων στο ArcGIS μέσω της εργαλειοθήκης HEC-GeoRAS. Αρχικά 

απαιτείται η μετατροπή του αρχείου SDF σε XML με την χρήση της εντολής “Import RAS 

SDF File”. Έπειτα, με την εντολή “RAS Mapping → Layer Setup” ρυθμίζουμε τις 

παραμέτρους στο νέο Layer το οποίο θα δημιουργηθεί και θα εμφανίζεται στον πίνακα 

περιεχομένων. Συγκεκριμένα, ορίζουμε το όνομα και τον φάκελο αποθήκευσης του Layer. 

Τέλος, με την εντολή “RAS Mapping → Import RAS Data” εισάγουμε τα αποτελέσματα 

του HEC-RAS. 
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(γ) Σύνθεση πιεζομετρικών χαρτών ακολουθώντας την σειρά εντολών “RAS Mapping → 

Inundation Mapping → Water Surface Generation” (βλ. Σχήμα 5.2). Δημιουργούνται 

πιεζομετρικοί χάρτες και για τα τέσσερα σενάρια τα οποία μελετήθηκαν κατά την 

υδραυλική προσομοίωση. 

 

Σχήμα 5.2: Πορεία σύνθεσης πιεζομετρικών χαρτών 

Οι πιεζομετρικοί χάρτες απεικονίζουν την μορφολογία της πιεζομετρικής επιφάνειας. Στο 

Σχήμα 5.3 παρουσιάζεται ο πιεζομετρικός χάρτης για παροχή 640 m3/s, ο οποίος εμφανίζει 

μικρές διαφορές με τον πιεζομετρικό χάρτη για παροχή 800 m3/s (Σχήμα 5.4), οι οποίες 

εντοπίζονται κυρίως στις τελευταίες διατομές στο κατάντη τμήμα του ποταμού. Η 

μεγαλύτερη διαφορά εμφανίζεται στον πιεζομετρικό χάρτη για παροχή 1700 m3/s (Σχήμα 

5.5), επίσης, στο κατάντη τμήμα του ποταμού. 
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Σχήμα 5.3: Πιεζομετρικός χάρτης για παροχή 640 m3/s 
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Σχήμα 5.4: Πιεζομετρικός χάρτης για παροχή 800 m3/s 
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Σχήμα 5.5: Πιεζομετρικός χάρτης για παροχή 1700 m3/s 
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(δ) Σύνθεση χαρτών πλημμυρικής κατάκλυσης με τις εντολές “RAS Mapping → Inundation 

Mapping → Floodplain Delineation Using Rasters” (βλ. Σχήμα 5.6). 

 

Σχήμα 5.6: Πορεία σύνθεσης χαρτών πλημμυρικής κατάκλυσης 

Οι χάρτες πλημμυρικής κατάκλυσης περιλαμβάνουν τα όρια κατάκλυσης και τα βάθη του 

νερού τα οποία προέκυψαν από την υψομετρική διαφορά κατά την σύγκριση του 

πιεζομετρικού χάρτη με το ψηφιακό μοντέλο εδάφους. 

Στο Σχήμα 5.7 παρουσιάζεται ο πλημμυρικός χάρτης για παροχή 640 m3/s ο οποίος έχει 

μέγιστο ύψος στάθμης νερού τα 7.20 m, περίπου. Ο πλημμυρικός χάρτης για παροχή 800 

m3/s (Σχήμα 5.8) έχει μέγιστο ύψος στάθμης νερού τα 7.50 m, περίπου και παρουσιάζει μια 

μικρή αύξηση στο ανάπτυγμα της πλημμύρας κυρίως στο κομμάτι του ποταμού το οποίο 

περικλείει την πόλη της Άρτας. Στο Σχήμα 5.9 παρουσιάζεται ο πλημμυρικός χάρτης για 

παροχή 1700 m3/s. Στον συγκεκριμένο χάρτη παρατηρούμε μείωση του ύψους της στάθμης 

του νερού στα 6.80 m περίπου και εκτόνωση της πλημμύρας δεξιά και αριστερά του 

ποταμού σε όλο το μήκος του κυρίως όμως στο τμήμα κατάντη του φράγματος Πουρνάρι 

ΙΙ. 
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Σχήμα 5.7: Πλημμυρικός χάρτης για παροχή 640 m3/s 
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Σχήμα 5.8: Πλημμυρικός χάρτης για παροχή 800 m3/s 
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Σχήμα 5.9: Πλημμυρικός χάρτης για παροχή 1700 m3/s 

Είναι επίσης σημαντικό να εξετάσουμε τα όρια του πλημμυρικού πεδίου για κάθε σενάριο σε 

σχέση με τα όρια της πόλης της Άρτας και των κτισμάτων που βρίσκονται κοντά στις όχθες του 

ποταμού και ενδέχεται να πληγούν. Στο Σχήμα 5.10 παρουσιάζονται τα όρια της πλημμυρικής 

επιφάνειας για παροχή 640 m3/s όπως αυτά αποτυπώνονται πάνω στον χάρτη της Άρτας. Είναι 

φανερό ότι δεν προκαλούνται ιδιαίτερα προβλήματα στην πόλη της Άρτας καθώς το σύνολο της 

παροχής διοχετεύεται σχεδόν αποκλειστικά από τον ποταμό. Στο Σχήμα 5.11 και στο Σχήμα 5.12 

παρουσιάζονται τα όρια του πλημμυρικού πεδίου για παροχή 800 m3/s και 1700 m3/s αντίστοιχα, 

πάνω στον ίδιο χάρτη της Άρτας. Για παροχή 800 m3/s το πλημμυρικό πεδίο είναι επίσης 

περιορισμένο στα όρια του ποταμού ενώ για παροχή 1700 m3/s το πλημμυρικό πεδίο φαίνεται να 

έχει εξαπλωθεί εγκάρσια στον ποταμό και να δημιουργεί προβλήματα σε κάποια κτίσματα, 

κυρίως στο τμήμα του ποταμού ανάντη της Γέφυρας της Άρτας. 
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Σχήμα 5.10: Όρια πλημμυρικού πεδίου για παροχή 640 m3/s  
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Σχήμα 5.11: Όρια πλημμυρικού πεδίου για παροχή 800 m3/s 
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Σχήμα 5.12: Όρια πλημμυρικού πεδίου για παροχή 1700 m3/s 
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5.2 Πλημμυρικοί χάρτες με βάση τα αποτελέσματα του LISFLOOD-FP 

Η υδραυλική προσομοίωση η οποία πραγματοποιήθηκε με την βοήθεια του προγράμματος 

LISFLOOD-FP μας παρέχει πληροφορίες για τα βάθη νερού στα παραγόμενα αρχεία με 

επέκταση “.wd”. Για την εισαγωγή αυτών των αρχείων σε περιβάλλον ArcGIS και την σύνθεση 

των πλημμυρικών χαρτών ακολουθείται η παρακάτω διαδικασία: 

(α) Μετατροπή των αρχείων με επέκταση “.wd” σε αρχεία τύπου ascii με επέκταση “.asc”. 

(β) Εισαγωγή των αρχείων αυτών στο ArcGIS και μετατροπή τους σε Raster με την χρήση των 

εντολών “Arc Toolbox → Conversion Tools → To Raster → ASCII to Raster”. Στο 

παράθυρο διαλόγου το οποίο εμφανίζεται εισάγουμε το αρχείο ascii, το οποίο περιέχει τα 

βάθη νερού και ορίζουμε τον φάκελο στον οποίο θα αποθηκευτεί το αρχείο raster. 

Στο Σχήμα 5.13 παρουσιάζεται ο πλημμυρικός χάρτης για παροχή 640 m3/s. Το μέγιστο 

ύψος στάθμης νερού φτάνει τα 8.00 m και είναι το ίδιο με το ύψος νερού του πλημμυρικού 

χάρτη για παροχή 800 m3/s (Σχήμα 5.14). Παρουσιάζεται, ωστόσο, διαφορά στο 

κατακλυζόμενο πλημμυρικό πεδίο, τόσο στο τμήμα του ποταμού το οποίο περικλείει την 

Άρτα όσο και στο πλέον κατάντη τμήμα του ποταμού. Για παροχή 1700 m3/s ο 

πλημμυρικός χάρτης (Σχήμα 5.15) παρουσιάζει πολύ μεγάλη αύξηση και στο ύψος νερού 

(12.00 m) και στο κατακλυζόμενο πλημμυρικό πεδίο. 
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Σχήμα 5.13: Πλημμυρικός χάρτης για παροχή 640 m3/s 
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Σχήμα 5.14: Πλημμυρικός χάρτης για παροχή 800 m3/s 
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Σχήμα 5.15: Πλημμυρικός χάρτης για παροχή 1700 m3/s 

Στα επόμενα σχήματα παρουσιάζονται τα όρια των πλημμυρικών πεδίων για κάθε σενάριο που 

μελετήθηκε, σε σχέση με τα όρια της πόλης της Άρτας. Συγκεκριμένα, στο Σχήμα 5.16 

παρουσιάζονται τα όρια του πλημμυρικού πεδίου όπως προέκυψαν για παροχή 640 m3/s. Στο 

τμήμα του ποταμού ανάντη της Γέφυρας της Άρτας το πλημμυρικό πεδίο παρουσιάζει 

ανάπτυγμα εγκάρσια του κυρίως ρεύματος, ενώ στα κατάντη η διόδευση της πλημμύρας γίνεται 

εξ ολοκλήρου εντός της κοίτης του ποταμού. Στο Σχήμα 5.17 παρουσιάζεται το πλημμυρικό 

πεδίο για παροχή 800 m3/s και στο Σχήμα 5.18 για παροχή 1700 m3/s. Για παροχή 800 m3/s το 

πλημμυρικό πεδίο δημιουργεί προβλήματα σε κτίσματα βορειοδυτικά της Γέφυρας της Άρτας 

και στα όρια του ποταμού ανάντη αυτής. Για παροχή 1700 m3/s η εγκάρσια εξάπλωση του 

πλημμυρικού πεδίου σε όλο το μήκος του ποταμού κατάντη του φράγματος Πουρνάρι ΙΙ 

προκαλεί προβλήματα σε κτίσματα τόσο δυτικά όσο και ανατολικά του ποταμού καθώς και στα 

χαμηλότερα σημεία της ίδιας της πόλης της Άρτας. 
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Σχήμα 5.16: Όρια πλημμυρικού πεδίου για παροχή 640 m3/s 
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Σχήμα 5.17: Όρια πλημμυρικού πεδίου για παροχή 800 m3/s 
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Σχήμα 5.18: Όρια πλημμυρικού πεδίου για παροχή 1700 m3/s 
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5.3 Σύγκριση πλημμυρικών χαρτών 

Στους πλημμυρικούς χάρτες οι οποίοι παρουσιάστηκαν στις Ενότητες 5.1 και 5.2 παρατηρούμε 

ότι τα αποτελέσματα των δύο προγραμμάτων έχουν σημαντικές διαφορές μεταξύ τους. Πιο 

συγκεκριμένα, για παροχή 640 m3/s ο πλημμυρικός χάρτης ο οποίος προέκυψε από προσομοίωση 

στο πρόγραμμα HEC-RAS (Σχήμα 5.7) έχει μέγιστο βάθος νερού τα 7.20 m περίπου, έναντι των 

8.00 m που είναι το μέγιστο βάθος νερού κατά την υδραυλική προσομοίωση στο LISFLOOD-FP 

(Σχήμα 5.13). Επίσης, οι δύο χάρτες παρουσιάζουν αποκλίσεις στην έκταση του κατακλυζόμενου 

πλημμυρικού πεδίου. Σύμφωνα με το Σχήμα 5.19 η διαφορά της κατακλυζόμενης πλημμυρικής 

επιφάνειας είναι 0.29 km2 (2.10 km2 σύμφωνα με το HEC-RAS και 2.39 km2 σύμφωνα με το 

LISFLOOD-FP).   

 

Σχήμα 5.19: Εμβαδά κατακλυζόμενης πλημμυρικής επιφάνειας για παροχή 640 m3/s όπως προέκυψαν από 
τα μοντέλα HEC-RAS (αριστερά) και LISFLOOD-FP (δεξιά).  

Για παροχή 800 m3/s η διαφορά του μέγιστου βάθους νερού είναι 0.50 m περίπου (7.50 m στο 

HEC-RAS και 8.00 στο LIFLOOD-FP). Επίσης, η έκταση του κατακλυζόμενου πλημμυρικού 

πεδίου στον χάρτη ο οποίος προέκυψε από το LISFLOOD-FP (Σχήμα 5.14) είναι 3.35 km2, ενώ 

αυτή που προέκυψε κατά την υδραυλική προσομοίωση στο HEC-RAS (Σχήμα 5.8) είναι κατά 

1.15 km2 μικρότερη  (δηλαδή 2.20 km2). Η διαφορά αυτή και παρουσιάζεται στο Σχήμα 5.20. 
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Σχήμα 5.20: Εμβαδά κατακλυζόμενης πλημμυρικής επιφάνειας για παροχή 800 m3/s όπως προέκυψαν από 
τα μοντέλα HEC-RAS (αριστερά) και LISFLOOD-FP (δεξιά). 

Στους πλημμυρικούς χάρτες για παροχή 1700 m3/s οι διαφορές τόσο στο μέγιστο βάθος νερού 

όσο και στην έκταση της πλημμύρας είναι πολύ μεγαλύτερες. Συγκεκριμένα, στον πλημμυρικό 

χάρτη από την υδραυλική προσομοίωση στο HEC-RAS (Σχήμα 5.9) το μέγιστο βάθος νερού 

φτάνει τα 6.80 m και η έκταση του κατακλυζόμενου πλημμυρικού πεδίου είναι 2.62 km2 ενώ 

στον πλημμυρικό χάρτη από την υδραυλική προσομοίωση στο LISFLOOD-FP (Σχήμα 5.15) το 

μέγιστο βάθος νερού φτάνει τα 12.00 m και η έκταση του κατακλυζόμενου πλημμυρικού πεδίου 

είναι 8.69 km2. Στο Σχήμα 5.21 παρουσιάζεται η διαφορά για το κατακλυζόμενο πλημμυρικό 

πεδίο και είναι ίση με 6.07 km2. 
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Σχήμα 5.21: Εμβαδά κατακλυζόμενης πλημμυρικής επιφάνειας για παροχή 1700 m3/s όπως προέκυψαν 
από τα μοντέλα HEC-RAS (αριστερά) και LISFLOOD-FP (δεξιά). 
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Κεφάλαιο 6ο  

6 Πλημμύρες στο δήμο Αρταίων  

6.1 Πλημμύρα 2005 

Κατά τη χρονική περίοδο 28-31/12/2005 εκδηλώθηκε στον Άραχθο μια σειρά από έντονα 

πλημμυρικά φαινόμενα τα οποία περιγράφονται από την εμφάνιση δύο πλημμυρικών αιχμών. 

Συγκεκριμένα, στις 28/12/2005 η συνολική παροχή εκροής (από εκχειλιστή και σταθμό 

παραγωγής ενέργειας) από τον ταμιευτήρα Πουρνάρι Ι έφτασε τα 1700 m3/s με ύψος στάθμης τα 

117.50 m, ενώ στις 30/12/2005 τα 1600 m3/s με ύψος στάθμης ταμιευτήρα τα 117.76 m. Και στις 

δυο περιπτώσεις, οι μονάδες του σταθμού παραγωγής ενέργειας λειτουργούσαν στο μέγιστο (με 

παροχή 500 m3/s). 

Οι υπεύθυνοι της ΔΕΗ προκειμένου να εξασφαλίσουν μια ήπια και ασφαλή διόδευση πλημμύρας 

προχώρησαν σε μερικό άνοιγμα των θυροφραγμάτων του εκχειλιστή, όταν η στάθμη στον 

ταμιευτήρα πλησίαζε τα 118 m και η παροχή εισροής ήταν περίπου 1600 m3/s. Το άνοιγμα είχε 

ως αποτέλεσμα να διοχετευτούν στον ποταμό συνολικά 800 m3/s, 300 m3/s από τα 

θυροφράγματα του εκχειλιστή και 500 m3/s από το σύστημα παραγωγής ενέργειας. Όπως 

φαίνεται και στο Σχήμα 6.1 ο εκχειλιστής παρέμεινε ανοιχτός για 60 hr.    

Το άνοιγμα των θυροφραγμάτων στην συγκεκριμένη στάθμη ταμιευτήρα αντιβαίνει τους 

κανόνες λειτουργίας του εκχειλιστή, οι οποίοι παρουσιάζονται στην Ενότητα 2.4 και ορίζουν ότι 

το άνοιγμα γίνεται όταν η στάθμη στον ταμιευτήρα φτάσει τα 120 m. Η συγκεκριμένη επιλογή 

είχε ως αποτέλεσμα την πτώση της στάθμης του ταμιευτήρα και έτσι στη δεύτερη παροχή αιχμής 

η στάθμη του ταμιευτήρα δεν έφτασε τα 120 m και αποσοβήθηκε η διοχέτευση παροχής ίση με 

1200 m3/s.   

Τα παραπάνω παρουσιάζονται οπτικά στα δυο επόμενα σχήματα (Σχήμα 6.1 και Σχήμα 6.2). Στο 

Σχήμα 6.1 παρουσιάζεται η μεταβολή εισροής – εκροής του ταμιευτήρα και του ύψους στάθμης 

του και στο Σχήμα 6.2 παρουσιάζεται η μεταβολή εισροής – εκροής του ταμιευτήρα και του 

αποθέματος σε σχέση με τον χρόνο. Η μέγιστη συνολική παροχή εκροής αντιστοιχεί σε 800 m3/s.  
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Σχήμα 6.1: Διάγραμμα εισροής – εκροής και στάθμης ταμιευτήρα για τη λειτουργία συστήματος 
εκχειλιστή όπως πραγματοποιήθηκε (Πηγή: Μαμάσης, 2014, ύστερα από επεξεργασία)   

 

 

Σχήμα 6.2: Διάγραμμα εισροής – εκροής και αποθέματος ταμιευτήρα για τη λειτουργία συστήματος 
εκχειλιστή όπως πραγματοποιήθηκε (Πηγή: Μαμάσης, 2014, ύστερα από επεξεργασία) 
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Στη συνέχεια εξετάζονται άλλα δυο σενάρια διαχείρισης του εκχειλιστή, τα οποία 

διαφοροποιούνται από το πραγματικό ως προς το χρόνο ανοίγματος του εκχειλιστή και άρα την 

συνολική παροχή εκροής. 

(α) Αν το άνοιγμα των θυροφραγμάτων γινόταν με βάση τους κανόνες λειτουργίας του 

εκχειλιστή, όταν δηλαδή η στάθμη του ταμιευτήρα έφτανε τα 120 m, η παροχή εκροής του 

εκχειλιστή θα έφτανε τα 1200 m3/s και η συνολική παροχή στον ποταμό θα έφτανε τα 1700 

m3/s. Είναι φανερό ότι στην περίπτωση αυτή η πλημμύρα κατάντη του φράγματος θα ήταν 

πολύ μεγαλύτερη όπως προκύπτει και από την υδραυλική προσομοίωση στις Ενότητες 5.1 

και 5.2 για το συγκεκριμένο σενάριο. Στο Σχήμα 6.3 παρουσιάζεται η μεταβολή της εισροής 

– εκροής του ταμιευτήρα και του αποθέματος σε σχέση με τον χρόνο. Η μέγιστη συνολική 

παροχή εκροής αντιστοιχεί σε 1700 m3/s. Σε αυτή την περίπτωση ο εκχειλιστής θα έπρεπε να 

μείνει ανοιχτός για 15 hr.  

 

Σχήμα 6.3: Διάγραμμα εισροής – εκροής ταμιευτήρα και αποθέματος για το σενάριο με άνοιγμα 
εκχειλιστή με στάθμη ταμιευτήρα στα 120 m (Πηγή: Μαμάσης, 2014, ύστερα από επεξεργασία) 

(β) Αν το άνοιγμα του εκχειλιστή γινόταν όταν η στάθμη του ταμιευτήρα ήταν στα 118 m αλλά 

με παροχή εκροής από τον εκχειλιστή ίση με 140 m3/s (640 m3/s συνολικά) τότε η στάθμη 

του ταμιευτήρα θα έφτανε οριακά τα 120 m κατά τη διάρκεια της δεύτερης αιχμής. Στην 

περίπτωση αυτή, η πλημμύρα κατάντη του φράγματος θα ήταν αισθητά περιορισμένη, όπως 

φαίνεται και στους πλημμυρικούς χάρτες στο Κεφάλαιο 5. Ο χειρισμός αυτός κρίνεται ως ο 
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βέλτιστος δυνατός. Ωστόσο, αξίζει να σημειωθεί ότι κάτι τέτοιο δεν θα μπορούσε να 

προεξοφληθεί αφού το φαινόμενο παρουσιάζει μεγάλη αβεβαιότητα και δεν είναι δυνατόν να 

προβλεφθεί εκ των προτέρων η ακριβής τιμή της παροχής αιχμής μιας πλημμύρας και ο 

ακριβής χρόνος στον οποίο θα εκδηλωθεί. Στο Σχήμα 6.4 παρουσιάζεται η μεταβολή της 

εισροής – εκροής και του αποθέματος του ταμιευτήρα σε σχέση με τον χρόνο. Η μέγιστη 

συνολική παροχή εκροής αντιστοιχεί σε 640 m3/s. 

 

Σχήμα 6.4: Διάγραμμα εισροής – εκροής και αποθέματος ταμιευτήρα για το σενάριο με άνοιγμα 
εκχειλιστή με στάθμη ταμιευτήρα στα 118 m και με παροχή εκχειλιστή ίση με 140 m3/s (Πηγή: Μαμάσης, 

2014, ύστερα από επεξεργασία) 

6.2 Πλημμύρα 2015 

Στις 31/1/2015 έως 1/2/2015 συνέβη στον Άραχθο ένα ακόμη έντονο πλημμυρικό φαινόμενο. Οι 

έντονες και διαρκείς βροχοπτώσεις των δυο αυτών ημερών προκάλεσαν την εισροή μεγάλης 

παροχής στον ταμιευτήρα του Πουρναρίου. Οι διαχειριστές του φράγματος προχώρησαν σε 

άνοιγμα των θυροφραγμάτων του εκχειλιστή όταν η στάθμη στον ταμιευτήρα έφτασε τα 120 m 

αφήνοντας 1200 m3/s από τον εκχειλιστή του φράγματος. Η συνολική παροχή εκροής στον 

ποταμό, λαμβάνοντας υπόψη και τα 500 m3/s του συστήματος παραγωγής ενέργειας, έφτασε τα 

1700 m3/s. Το συγκεκριμένο γεγονός αντιστοιχεί σε ένα από τα δύο εναλλακτικά σενάρια 
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διαχείρισης του εκχειλιστή κατά την μελέτη της πλημμύρας του 2005 και αναλύεται στα 

Κεφάλαια 3, 4 και 5. 

Στην συνέχεια παρατίθενται εικόνες οι οποίες παρουσιάζουν το μέγεθος της πλημμύρας σε 

κάποια χαρακτηριστικά σημεία της πόλης, του φράγματος και του ποταμού (Σχήμα 6.5 - Σχήμα 

6.8). 

 

Σχήμα 6.5: Εκροή από τον εκχειλιστή του φράγματος (Πηγή: http://www.radiogamma.gr)   
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Σχήμα 6.6: Εκροή από τον εκχειλιστή του φράγματος (Πηγή: http://www.parapolitika.gr/parapolitikablog) 

 

Σχήμα 6.7: Η Γέφυρα της Άρτας (Πηγή: http://arta-mou.blogspot.gr/2015/02/blog-post.html) 
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Σχήμα 6.8: Το παραποτάμιο πάρκο της Άρτας (Πηγή: http://nakedtruth.gr)  

Τέλος πραγματοποιήθηκε υδραυλική προσομοίωση για ένα ακόμη σενάριο διαχείρισης του 

εκχειλιστή κατά την πλημμύρα του 2015. Στο συγκεκριμένο σενάριο η μέγιστη παροχή του 

ποταμού φτάνει τα 2200 m3/s θεωρώντας ότι από τον εκχειλιστή του φράγματος αφέθηκαν 1700 

m3/s και άλλα 500 m3/s από το σύστημα παραγωγής ενέργειας. Στο Σχήμα 6.9 και στο Σχήμα 

6.10 παρουσιάζονται ο πιεζομετρικός και ο πλημμυρικός χάρτης για παροχή 2200 m3/s όπως 

προέκυψαν από την υδραυλική προσομοίωση στο HEC-RAS, ενώ στο Σχήμα 6.12 

παρουσιάζεται ο πλημμυρικός χάρτης για την ίδια παροχή όπως προέκυψε από την υδραυλική 

προσομοίωση στο LISFLOOD-FP. Για την υδραυλική προσομοίωση και την σύνθεση χαρτών 

για την συγκεκριμένη παροχή ακολουθήθηκαν τα βήματα τα οποία παρουσιάζονται στα 

Κεφάλαια 3, 4 και 5. Επίσης, στο Σχήμα 6.11 και στο Σχήμα 6.13 παρουσιάζονται τα όρια της 

πλημμυρικής επιφάνειας σε σχέση με τα όρια της πόλης της Άρτας όπως αυτά προέκυψαν από 

την προσομοίωση στο HEC-RAS και στο LISFLOOD-FP, αντίστοιχα, για παροχή 2200 m3/s. 



 

86 
 

 

Σχήμα 6.9: Πιεζομετρικός χάρτης για παροχή 2200 m3/s  
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Σχήμα 6.10: Πλημμυρικός χάρτης για παροχή 2200 m3/s 
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Σχήμα 6.11: Όρια πλημμυρικού πεδίου για παροχή 2200 m3/s 
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Σχήμα 6.12: πλημμυρικός χάρτης για παροχή 2200 m3/s 
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Σχήμα 6.13: Όρια πλημμυρικού πεδίου για παροχή 2200 m3/s 

Συγκρίνοντας τους δύο πλημμυρικούς χάρτες παρατηρούμε ότι η διαφορά στην περιοχή 

κατάκλυσης του πλημμυρικού πεδίου είναι πάρα πολύ μεγάλη όπως επίσης και στο μέγιστο 

βάθος νερού. Στην υδραυλική προσομοίωση που έγινε με το HEC-RAS προκύπτει μέγιστο βάθος 

νερού τα 7.50 m και έκταση πλημμυρικού πεδίου ίση με 2.80 km2 σε αντίθεση με την υδραυλική 

προσομοίωση στο LISFLOOD-FP από το οποίο προκύπτει μέγιστο βάθος νερού τα 14 m και 

έκταση πλημμυρικού πεδίου 11.09 km2. Η διαφορά στην έκταση του πλημμυρικού πεδίου είναι 

8.29 km2 και παρουσιάζεται στο Σχήμα 6.14. 

Στο Σχήμα 6.15 γίνεται σύγκριση των κατακλυζόμενων περιοχών όπως προέκυψαν από 

προσομοίωση από τα μοντέλα HEC-RAS και LISFLOOD-FP για τα σενάρια πλημμυρικών 

παροχών που μελετήθηκαν. Όπως μπορούμε να παρατηρήσουμε για τις μικρές πλημμυρικές 

αιχμές οι διαφορές στους δυο χάρτες είναι μικρές, ενώ για μεγαλύτερες πλημμυρικές αιχμές οι 

διαφορές στους πλημμυρικούς χάρτες αυξάνονται. Η αύξηση της απόκλισης μεταξύ των 

αποτελεσμάτων των δυο μοντέλων με την αύξηση της παροχής ήταν αναμενόμενη καθώς η 
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πλημμύρα ξεφεύγει από την κύρια ροής του ποταμού, με εκδήλωση ταυτόχρονης εγκάρσιας 

κίνησης. Η κίνηση αυτή προσομοιώνεται αποκλειστικά από το ψευδο-διδιάστατο μοντέλο 

LISFLOOD-FP.     

 

Σχήμα 6.14: Εμβαδά κατακλυζόμενης πλημμυρικής επιφάνειας για παροχή 2200 m3/s όπως προέκυψαν 
από τα μοντέλα HEC-RAS (αριστερά) και LISFLOOD-FP (δεξιά).   

 

Σχήμα 6.15: Σύγκριση εμβαδού κατακλυζόμενων επιφανειών από προσομοίωση με το HEC-RAS και 
LISFLOOD-FP για διαφορετικά μεγέθη πλημμυρικών παροχών  
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Κεφάλαιο 7ο  

7 Συμπεράσματα - Σύνοψη 

Τα βασικά σημεία της παρούσας εργασίας συνοψίζονται ως εξής: 

 Στα πλαίσια της παρούσας εργασίας μελετήθηκε η πλημμυρική δραστηριότητα του Ποταμού 

Άραχθου για τμήμα μήκους 11.0 km κατάντη του υδροηλεκτρικού φράγματος Πουρνάρι Ι. Η 

έντονη πλημμυρική δραστηριότητα του υπό μελέτη τμήματος κρίνεται ιδιαίτερα σημαντική 

δεδομένου ότι αυτό περικλείει την πόλη της Άρτας και βρίσκεται σε μικρή απόσταση από 

αυτή. 

 Για την υδραυλική προσομοίωση επιλέχθηκαν τέσσερα διαφορετικά σενάρια διαχείρισης του 

εκχειλιστή του φράγματος Πουρνάρι Ι, τα οποία προκαλούν πλημμυρικές αιχμές 

διαφορετικού μεγέθους (διαφορετικής περιόδου επαναφοράς). Τα μεγέθη πλημμυρικών 

αιχμών που ακολουθούν περιλαμβάνουν εκτός από την παροχή που ελευθερώνεται κάθε 

φορά από τον εκχειλιστή και την παροχή εκροής του σταθμού παραγωγής ενέργειας που είναι 

σταθερή και ίση με 500 m3/s. Το πρώτο σενάριο αντιστοιχεί στην πραγματική λειτουργία του 

εκχειλιστή, κατά το επεισόδιο της περιόδου 28-31/12/2005, που είχε σαν αποτέλεσμα παροχή 

αιχμής 800 m3/s. Πέραν αυτού, μελετήθηκαν ακόμα δυο εναλλακτικά σενάρια τα οποία 

διαφοροποιούνται ως προς το χρόνο ανοίγματος του εκχειλιστή σε σχέση με την μέγιστη 

εισροή στον ταμιευτήρα. Οι παροχές των σεναρίων αυτών είναι 640 και 1700 m3/s, 

αντίστοιχα. Η τελευταία τιμή αποτελεί, επίσης, εκτίμηση της παροχής που ελευθερώθηκε από 

τον εκχειλιστή κατά τη διάρκεια του γεγονός την 1/2/2015. Τέλος, πραγματοποιήθηκε 

υδραυλική προσομοίωση για μια μεγαλύτερη τιμή, ίση με 2200 m3/s.  

 Η υδραυλική προσομοίωση της πλημμύρας έγινε με χρήση των λογισμικών HEC-RAS 4.0 

και LISFLOOD-FP 4.5.0, κάνοντας παραδοχή για μόνιμη ροή. Το πρώτο μοντέλο 

υποστηρίζει μονοδιάστατη ροή, ενώ το δεύτερο υιοθετεί μεθόδους για την προσομοίωση του 

αναπτύγματος της πλημμύρας εγκάρσια στο κυρίως ρεύμα ροής (ψευδο-διδιάστατη ανάλυση) 

και, θεωρητικά τουλάχιστον, αντιπροσωπεύει πιστότερα την πραγματικότητα.   

 Τα αποτελέσματα των προσομοιώσεων για κάθε ένα από τα παραπάνω σενάρια 

παρουσιάζονται υπό την μορφή πλημμυρικών χαρτών όπως προβλέπεται από την Κοινοτική 

Οδηγία 2007/60/ΕΚ. 
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Τα συμπεράσματα που προέκυψαν από την ανάλυση και εκτέλεση των προσομοιώσεων με τα 

δυο υπολογιστικά πακέτα είναι τα εξής: 

 Παρά το γεγονός ότι ο απαιτούμενος υπολογιστικός χρόνος προσομοίωσης στο πακέτο HEC-

RAS είναι πολύ μικρός (1.5 – 2 λεπτά ανά προσομοίωση), η δημιουργία του γεωμετρικού 

αρχείου σε περιβάλλον ArcGIS ήταν μια αρκετά επίπονη και χρονοβόρα διαδικασία αφού το 

αρχείο έπρεπε να διορθωθεί αρκετές φορές προκειμένου να αντιπροσωπεύει όσο το δυνατόν 

καλύτερα τις πραγματικές συνθήκες στην περιοχή μελέτης. Η διόρθωση περιελάμβανε 

πύκνωση των διατομών στα σημεία με λανθασμένα ή ελλιπή υψόμετρα.  

 Το ίδιο χρονοβόρα ήταν και η επεξεργασία του γεωμετρικού αρχείου για τη διόρθωση του 

πλάτους του ποταμού σε κάθε διατομή ξεχωριστά.  

 Στο LISFLOOD-FP η δημιουργία των αρχείων εισόδου του μοντέλου (αρχείο με τα 

γεωμετρικά χαρακτηριστικά του πλημμυρικού πεδίου, αρχείο με τους συντελεστές 

τραχύτητας Manning, αρχείο με τα γεωμετρικά χαρακτηριστικά του ποταμού και ένα αρχείο 

με τις οριακές συνθήκες του πλημμυρικού πεδίου) ήταν εύκολη και γρήγορη, δεδομένης της 

προεργασίας που είχε γίνει στο HEC-RAS και του ήδη έτοιμου γεωμετρικού αρχείου. Στο 

αρχείο με τα γεωμετρικά χαρακτηριστικά του ποταμού πραγματοποιήθηκε μια μικρή 

παρέμβαση στα υψόμετρα του ποταμού δεδομένου ότι το πρόγραμμα απαιτεί την ύπαρξη 

μόνο αρνητικών κλήσεων προς τα κατάντη. 

 Σε αντίθεση με το HEC-RAS ο υπολογιστικός χρόνος που απαιτείται για την εκτέλεση των 

προσομοιώσεων στο LISFLOOD-FP ήταν αρκετά μεγαλύτερος, γεγονός που αποτελεί το 

μεγάλο μειονέκτημα του προγράμματος. Ενδεικτικά, αξίζει να αναφερθεί ότι για την 

ολοκλήρωση της υδραυλικής προσομοίωσης 20 ωρών χρειάστηκαν 3.5 ώρες, ενώ για αυτή 

των 50 ωρών 8 ώρες, περίπου. Δεδομένου ότι για την προκαταρκτική ανάλυση και εύρεση 

του χρόνου σταθεροποίησης της ροής απαιτείται μεγάλο πλήθος δοκιμών, η χρήση του 

LISFLOOD-FP κρίνεται αποτρεπτική.  

 Τα αποτελέσματα της υδραυλικής προσομοίωσης από τα δυο μοντέλα εισήχθησαν στο 

ArcGIS όπου και δημιουργήθηκαν οι πλημμυρικοί χάρτες. Η διαδικασία σύνθεσης των 

πλημμυρικών χαρτών είναι τυπική και εύκολη, και συνεπώς δεν απαιτεί μεγάλο υπολογιστικό 

χρόνο. 
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Τα συμπεράσματα που προέκυψαν από την σύγκριση των αποτελεσμάτων των προσομοιώσεων 

από τα μοντέλα HEC-RAS και LISFLOOD-FP είναι τα εξής: 

 Το μέγιστο βάθος νερού και η έκταση του κατακλυζόμενου πλημμυρικού πεδίου είναι 

αρκετά μεγαλύτερα στους πλημμυρικούς χάρτες οι οποίοι προέκυψαν από το LISFLOOD-FP.  

 Για τις μικρές πλημμυρικές αιχμές οι διαφορές στους δυο χάρτες είναι μικρές, ενώ για 

μεγαλύτερες πλημμυρικές αιχμές οι διαφορές στους πλημμυρικούς χάρτες είναι εντονότερες. 

Συγκεκριμένα, για παροχές αιχμής 640 και 800 m3/s, η έκταση της κατακλυζόμενης περιοχής 

με το LISFLOOD-FP είναι μεγαλύτερη κατά 0.29 km2 και 1.15 km2 αντίστοιχα, σε σχέση με 

την αυτή που προέκυψε από το μοντέλο HEC-RAS. Για τις μεγαλύτερες παροχές αιχμής των 

1700 και 2200 m3/s οι διαφορές είναι αρκετά μεγαλύτερες, με τιμές 6.07 km2 και 8.29 km2, 

αντίστοιχα. Η αύξηση της απόκλισης μεταξύ των αποτελεσμάτων των δυο μοντέλων με την 

αύξηση της παροχής ήταν αναμενόμενη καθώς η πλημμύρα ξεφεύγει από την κύρια ροής του 

ποταμού, με εκδήλωση ταυτόχρονης εγκάρσιας κίνησης.     

 Σύμφωνα με μαρτυρίες από κατοίκους της πόλης της Άρτας ως προς την έκταση της 

πλημμύρας και πόσο αυτή προσέγγισε κατοικημένες περιοχές, μπορεί να ειπωθεί πως οι 

χάρτες που προέκυψαν από το LISFLOOD-FP ανταποκρίνονται περισσότερο στην 

πραγματικότητα. Φυσικά, η ύπαρξη μετρήσεων ή του ίχνους της πλημμύρας από 

δορυφορικές λήψεις θα επέτρεπε την εξαγωγή ασφαλέστερων συμπερασμάτων ως προς την 

επίδοση των μοντέλων και κατά πόσο αυτά αναπαριστούν πιστά την πραγματικότητα (δομική 

αβεβαιότητα μοντέλων).  

Τέλος, επιχειρείται η εξαγωγή συμπερασμάτων για τους κανόνες λειτουργίας του συστήματος 

εκχειλιστή του φράγματος Πουρνάρι Ι στην περίπτωση πλημμυρικών γεγονότων:  

 Οι επιπτώσεις από τους δυο διαφορετικούς τρόπους λειτουργίας του συστήματος εκχειλιστή, 

κατά τη διάρκεια των δύο έντονων πλημμυρικών γεγονότων στον Ποταμό Άραχθο (28-

31/12/2005 και 1/2/2015), μας οδηγεί στο συμπέρασμα πως ίσως θα ήταν χρήσιμο να 

επανεξεταστούν και να επαναπροσδιοριστούν οι κανόνες λειτουργίας του συστήματος 

εκχειλιστή και πιο συγκεκριμένα το ύψος στάθμης του ταμιευτήρα πάνω από το οποίο θα 

πρέπει να αρχίσει το άνοιγμα του εκχειλιστή και η διοχέτευση παροχής στα κατάντη.  

 Σύμφωνα με τον υπάρχοντα κανονισμό, οι διαχειριστές θα πρέπει να αφήσουν παροχή ίση με 

την παροχή εισροής στον ταμιευτήρα όταν η στάθμη του ταμιευτήρα φτάσει στα 120 m. Και 
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στα δυο γεγονότα, η παροχή αυτή ήταν πάνω από 1000 m3/s. Ωστόσο, κατά την πλημμύρα 

του 2005 ο τότε διαχειριστής επέλεξε να ανοίξει τα θυροφράγματα του εκχειλιστή πριν η 

στάθμη στον ταμιευτήρα φτάσει τα 120 m δημιουργώντας έτσι επιπλέον αντιπλημμυρικό 

όγκο στον ταμιευτήρα για την ανάσχεση της δεύτερης παροχής αιχμής του ίδιου επεισοδίου. 

Το πρόωρο άνοιγμα του εκχειλιστή είχε σαν αποτέλεσμα να διοχετευτούν στον ποταμό 

συνολικά 800 m3/s και όχι τα 1700 m3/s που αντιστοιχούν σε στάθμη ταμιευτήρα ίση με 120 

m και το υδροηλεκτρικό σύστημα σε λειτουργία. Από την κίνηση αυτή οδηγούμαστε στο 

συμπέρασμα ότι ο διαχειριστής ήταν ενήμερος, από μετεωρολογικές προβλέψεις, για το 

δεύτερο επεισόδιο που ακολουθεί. Αντίθετα, κατά την πλημμύρα του 2015 οι κανόνες 

λειτουργίας ακολουθήθηκαν επακριβώς και το άνοιγμα του εκχειλιστή έγινε όταν η στάθμη 

στον ταμιευτήρα έφτασε τα 120 m. Οι συνέπειες που είχαν οι δυο διαφορετικοί χειρισμοί ως 

προς την έκταση της κατακλυζόμενης έκτασης και το πόσο κοντά έφτασε η πλημμύρα στην 

πόλη της Άρτας αποτυπώνονται στους πλημμυρικούς χάρτες για αντίστοιχες αιχμές.  

 Από την ανάλυση προέκυψε πως ο τρόπος χειρισμού του εκχειλιστή κατά το επεισόδιο του 

2005 δεν ήταν ο βέλτιστος δυνατός δεδομένου ότι με την διοχέτευση μικρότερης (640 m3/s 

συνολικά) παροχής η στάθμη του ταμιευτήρα θα έφτανε οριακά τα 120 m κατά τη διάρκεια 

της δεύτερης αιχμής και το ανάπτυγμα της πλημμύρας μικρότερο. Ωστόσο, κάτι τέτοιο είναι 

αδύνατον να προβλεφθεί με ακρίβεια κατά τη διάρκεια εξέλιξης του φαινομένου λόγω της 

έντονης μεταβλητότητας και αβεβαιότητας που το χαρακτηρίζει.  

 Παρά το γεγονός ότι είναι εκτός του αντικειμένου της παρούσας εργασίας, αξίζει να 

αναφερθούν ορισμένα μεγέθη όσον αφορά την απώλεια ηλεκτρικής ενέργειας, και άρα 

χρημάτων, που επέφερε στη ΔΕΗ ο τρόπος χειρισμού του εκχειλιστή κατά τη διάρκεια του 

επεισοδίου του 2005. Με άνοιγμα του εκχειλιστή για 60 hr και παροχή εκροής 300 m3/s η 

ΔΕΗ είχε απώλειες 10 GWh ή, αντίστοιχα, 900.000 €. Με το βέλτιστο σενάριο διαχείρισης 

του εκχειλιστή (140 m3/s) οι απώλειες σε ενέργεια και χρήματα θα περιορίζονταν περίπου 

στο μισό.   
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